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Welcome 
 
You now have access to what we believe is the most versatile, capable, and easy to use ground 
based IRIG 106 Chapter 10 Recorder on the market.  This product was designed first and 
foremost to meet the demanding needs of the high paced data acquisition laboratory 
environment.   
 
Some of the features that make the IMUX G2 stand out include: 
 

• Intuitive Graphical User Interface (GUI) that gets you going right out of the box. 
• Individual channel reconfiguration on the fly with no impact to other channels or current 

operations. 
• Quick Global reconfiguration based on standard TMATS files. 
• Multiple simultaneous recording to local and Network Attached Storage (NAS) devices. 
• Network accessible control and monitoring. 
• Channel-specific lag adjustments to account for known fixed data link delays. 
• Real-time creation and recording of virtual PCM best data streams using Wyle’s Best Data 

Engine (BDE) technology. 
• Real-time links to OMEGA-SERV, allowing immediate integrated local or remote 

processing of recorded data using Wyle’s Powered-by-OMEGA (PBO) technology. 
• Embedded links to other high-end data processing tools such as the OMEGA Data 

Environment (ODE). 
 

At Wyle Telemetry and Data Systems, we are committed to helping our customers by providing 
tools that give end users easy access to their collected mission critical data.  We include input 
from telemetry users throughout the design phase of our products to make sure we add in the 
features that make your job easier. If you see something that you think needs to be changed, we 
want to hear from you. 
 
Any time you have questions or concerns, please send an e-mail to us at G2@wyle.com or give 
us a call at 301-863-1661. 
 
 
Tim Gatton 
Product Line Manager 
Wyle 
Telemetry and Data Systems 
  

mailto:G2@wylelabs.com�


 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This page intentionally left mostly blank. 
 
 



IMUX G2 – CHAPTER 10 REC0RDER  USER GUIDE 2.8p2 

i 
 

Table of Contents 
Welcome ................................................................................................................................. i 
Table of Contents..................................................................................................................... i 
Introduction............................................................................................................................ 1 

What Is IMUX G2? .............................................................................................................. 1 
What Is In the Manual? ........................................................................................................ 2 
How to Use the Manual ........................................................................................................ 2 
Getting Help From Within the Program .................................................................................. 3 
Using Training Mode ............................................................................................................ 3 

Getting Started ....................................................................................................................... 4 
Starting the Program ........................................................................................................... 4 
Opening the Primary Display Windows .................................................................................. 4 
Quick Start 1: A Simple Record and Playback Session ............................................................ 6 
Quick Start 2: Playback a Previously Recorded Session........................................................... 7 
Quick Start 3: Configuring a Channel .................................................................................... 8 
Quick Start 4: Selecting Media and Targets ........................................................................... 9 

Selecting Media ................................................................................................................ 9 
Selecting Targets ............................................................................................................. 9 

The Interface Explained......................................................................................................... 10 
The Application Window ..................................................................................................... 10 

The Menu Bar ................................................................................................................ 11 
The Toolbars .................................................................................................................. 12 

File Toolbar ................................................................................................................ 12 
View Toolbar .............................................................................................................. 13 
Recorder Transport Control Toolbar ............................................................................. 14 
Playback Constraints (Shuttle) Toolbar ......................................................................... 15 

The Classification Bar ..................................................................................................... 17 
The Status Tray ............................................................................................................. 17 

System Mode Information............................................................................................ 17 
System Status Information .......................................................................................... 18 
Time Channel Status Information ................................................................................. 18 

The Main Window .............................................................................................................. 21 
Recorder Transport Controls ........................................................................................... 21 
Recorded Time ............................................................................................................... 22 
Channel Grid .................................................................................................................. 23 

Channel Grid Title Bar ................................................................................................. 24 
Channel Status ........................................................................................................... 24 

Channel Status Information ...................................................................................... 26 
Snapshot Viewers ....................................................................................................... 28 

Analog Snapshot Viewer ........................................................................................... 28 
Analog Snapshot Viewer Toolbar ........................................................................... 28 
Analog Snapshot Controls ..................................................................................... 29 

Analog Audio Snapshot Viewer ................................................................................. 30 
Audio Snapshot Viewer Toolbar ............................................................................. 30 
Audio Snapshot Controls ....................................................................................... 30 

PCM Snapshot Viewer .............................................................................................. 32 
Record Enable Buttons ................................................................................................ 34 
Channel Mapping ........................................................................................................ 36 
Data Grid .................................................................................................................... 38 

Time Ruler .............................................................................................................. 39 
Zoom Buttons .......................................................................................................... 41 
Left and Right Constraint Markers ............................................................................. 41 



IMUX G2 – CHAPTER 10 REC0RDER  USER GUIDE 2.8p2 

ii 
 

Current Time Marker ................................................................................................ 42 
Event Marker ........................................................................................................... 42 
Right Click Options................................................................................................... 43 
Channel Configuration .............................................................................................. 44 
Analog Channel Configuration ................................................................................... 45 

Setting the Input and Output Filters ...................................................................... 46 
Analog Input Setup Screen ................................................................................... 47 
Analog Packet Format Setup Screen ...................................................................... 48 
Analog Advanced Input Setup Screen .................................................................... 49 
Analog Output Setup ............................................................................................ 50 

Analog Audio Channel Configuration ......................................................................... 51 
Audio Setup Screen .............................................................................................. 51 
Audio Advanced Setup Screen ............................................................................... 52 

PCM Channel Configuration ...................................................................................... 53 
Bit Sync Setup Screen ........................................................................................... 54 
PCM Input Setup Screen ....................................................................................... 55 
PCM Frame Format Screen .................................................................................... 57 
PCM Subframe Synchronization Format Screen ....................................................... 59 
PCM Advanced Input Setup Screen ........................................................................ 61 
PCM Output Setup ................................................................................................ 62 

UART Channel Configuration .................................................................................... 64 
UART Setup Screen .............................................................................................. 64 
UART Advanced Setup Screen ............................................................................... 65 

Video Channel Configuration .................................................................................... 66 
Video Setup Screen .............................................................................................. 66 
Video Format Details Screen ................................................................................. 67 
Video Advanced Setup Screen ............................................................................... 68 

Ethernet Channel Configuration ................................................................................ 68 
Ethernet Setup Screen .......................................................................................... 68 

1553 Channel Configuration ..................................................................................... 69 
1553 Setup Screen ............................................................................................... 69 
1553 Advanced Setup Screen ................................................................................ 70 
1553 Output Channel Setup Screen ....................................................................... 70 

429 Channel Configuration ....................................................................................... 71 
429 Setup Screen ................................................................................................. 71 
429 Advanced Input Setup Screen ......................................................................... 72 
429 Output Channel Setup Screen ......................................................................... 72 

Best Data Engine (BDE) PCM Channel Configuration .................................................. 73 
BDE PCM Setup Screen ......................................................................................... 73 

Status Log ..................................................................................................................... 78 
Menu Details ......................................................................................................................... 79 

File ................................................................................................................................... 79 
Setup ................................................................................................................................ 81 

Audio Feedback Enabled ................................................................................................. 81 
Record Nags Enabled ...................................................................................................... 82 
Media 90% Full Alarm..................................................................................................... 82 
Data Loop Thru Enabled ................................................................................................. 83 
Log Files Enabled ........................................................................................................... 83 
TMATS Setup Output Enabled ......................................................................................... 83 
Set Classification ............................................................................................................ 84 
Media Bandwidth Setup Menu ......................................................................................... 85 
Target Setup Window ..................................................................................................... 87 
Time Setup Window ....................................................................................................... 89 



IMUX G2 – CHAPTER 10 REC0RDER  USER GUIDE 2.8p2 

iii 
 

TMATS G Group Editor Window ....................................................................................... 91 
Built In Test and System Integrity Monitor Setup Window ................................................. 93 

View ................................................................................................................................. 95 
Ruler ................................................................................................................................. 96 
Transport .......................................................................................................................... 98 
Shuttle .............................................................................................................................. 99 
Tools .............................................................................................................................. 100 

Auto Align Multiple Chapter 10 Files............................................................................... 100 
Configure G2PBO Mapping ............................................................................................ 101 
Add BDE Virtual Channel ............................................................................................... 103 
Play in OMEGA-FILE ..................................................................................................... 103 
Analyze in ODE ............................................................................................................ 103 
View Chapter 10 File ..................................................................................................... 104 
Open TMATS in Wordpad .............................................................................................. 104 
Open TMATS in OTIS .................................................................................................... 104 
Start File Transfer Utility ............................................................................................... 105 
Start Standalone BDE ................................................................................................... 105 
Calculate PCM Rate ...................................................................................................... 105 
Export ......................................................................................................................... 105 

Help ................................................................................................................................ 106 
Remote Control of the IMUX G2 Recorder ............................................................................ 107 

Serial Control Setup ......................................................................................................... 107 
Telnet Control Setup ........................................................................................................ 107 
Using Telnet for Remote Control ....................................................................................... 108 

Appendix 1 – Frequently Asked Questions ............................................................................ 109 
Appendix 2 – Definitions ...................................................................................................... 112 
Appendix 3 – Icons, Accelerators, and Hot Keys .................................................................... 113 

File ................................................................................................................................. 113 
Setup .............................................................................................................................. 114 
View ............................................................................................................................... 115 
Ruler ............................................................................................................................... 115 
Transport ........................................................................................................................ 115 
Shuttle ............................................................................................................................ 116 
Tools .............................................................................................................................. 117 
Help ................................................................................................................................ 118 

Appendix 4 – IMUX G2 Hardware Configuration Files ............................................................ 119 
Appendix 5 – IMUX G2 System Configuration Files ............................................................... 125 
Appendix 6 – IMUX G2 Serial Controller Configuration Files ................................................... 128 
Appendix 7 – Mapping TMATS to IMUX G2 .......................................................................... 129 
Notes ................................................................................................................................. 144 

  



IMUX G2 – CHAPTER 10 REC0RDER  USER GUIDE 2.8p2 

iv 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This page intentionally left mostly blank. 



IMUX G2 – CHAPTER 10 REC0RDER  USER GUIDE 2.8p2 

1 
 

Introduction 

What Is IMUX G2? 
 
IMUX G2 is a ground/laboratory data recorder/reproducer that creates and ingests data files 
compliant with the IRIG 106 Chapter 10 Digital On-Board Recorder Standard.  The IMUX G2 
Graphical User Interface (GUI) is designed for easy hands-on use in a laboratory environment, 
yet the underlying and well documented TCP/IP command set allows full remote computer 
control across a network connection.  
 
Whether using the TCP/IP command set or the GUI described by this manual, a user has all the 
flexibility necessary to control all aspects of IMUX G2 recording and reproducing.  The interface 
allows a user to configure all input and output channels, manage multiple media and target 
locations, create different record lists for simultaneously recording different data sets to different 
locations, play back Chapter 10 compliant files, and select individual or multiple segments for 
simultaneous playback. 
 
The IMUX G2 GUI automatically interacts with the IMUX G2 Controller software, which is 
responsible for managing the operations of the IMUX G2 Chapter 10 Recorder.  Because of this, 
the GUI, or any remote connection, can be shut down and the Recorder will continue to operate.  
When a remote connection or the GUI is reopened, it receives updated status from the controller 
and is able to present that information to the user. 
 
IMUX G2 hardware can be configured in a myriad of ways with up to 256 input channels and 256 
output channels.  This manual includes details and examples that may not apply to your 
purchased hardware configuration.  We are constantly developing new input/output modules to 
better meet your needs.  If you notice that a particular channel type is not listed and have a 
need for it, contact the factory and we can discuss when it will be available. 
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What Is In the Manual? 
The manual has the following main sections. 
 

• Getting Started describes the basics of the IMUX G2 GUI and provides some one-page 
Quick Start guides to help you start recording and playing back data right out of the box. 

 
• The Interface Explained provides details on the purpose and use of each of the main 

windows as well as the Menu Bar, the Toolbars, and the Status Tray.  Each section starts 
with covering the general operation of each higher level item and then dives into the 
details to give you everything you need to know to take advantage of the little features 
that make IMUX G2 so versatile. 

 
• Menu Details provides any remaining details for all of the menu items.  In some cases, 

the menu items are just another way to do something that has already been covered in 
detail elsewhere.  For those items the details will be limited.  However, there are some 
things that are only available from the Menu Bar, and this section will provide all the 
details necessary to understand how to take advantage of those features. 

 
• Appendices include Definitions, Frequently Asked Questions, and a Cross Reference 

table that covers Icons, Accelerator Keys, and Hot Keys. 
 

How  to Use the Manual 
Depending on the level of experience you have, you may wish to use the manual in the following 
ways. 

• As a new user, read the Getting Started section to get a good idea about what the IMUX 
G2 can do and to learn how to perform the basic operations. When you understand the 
basics, refer to the remaining sections to read more about specific features. 

 
• When comfortable with the basic operation, review the section titled The Interface 

Explained, which covers the details of the main windows and how you can use the 
features to your advantage. 

 
• To understand how to set up and configure the system level aspects of the IMUX G2, 

read the Menu Details section 
 

• Use the Appendices as quick look-up tables for the information covered in this manual. 
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Getting Help From Within the Program 
The ultimate source of help is this manual, which is available from within the IMUX G2 GUI by 
selecting Help > Help from the Menu Bar or by pressing F1 while in the application. 
 

Using Training Mode 
The IMUX G2 GUI can operate in a training mode that does not require the installation of 
hardware.  It is not possible to record or play back data while operating within the training mode.  
Nor is it possible to use the Snapshot Viewers.  However, in all other ways, the interface will 
operate just as if it were processing data. 
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Getting Started 

Starting the Program 
The first time the IMUX G2 GUI is started, none of the display windows are activated.  In 
subsequent starts, the windows will be displayed just as they were when the application last 
closed. 
 
  
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Opening the Primary Display Windows 
The four primary displays can each be started in one of two ways: 
 

 
To view the Recorder Transport Control display, select View > Recorder Controls 
from the menu, or select the Recorder Transport Control icon on the toolbar. 

 

 
To view the Recorded Time display, select View > Recorded Time from the menu, or 
select the Recorded Time icon on the toolbar. 

 

 
To view the Channel Grid display, select View > Channel Grid from the menu, or 
select the Channel Grid icon on the toolbar. 

 

 
To view the Status Log display, select View > Status Log from the menu, or select 
the Status Log icon on the toolbar. 

 

View 
Toolbar 

File 
Toolbar 

Menu Bar 

Recorder 
Control 
Toolbar 

Main 
Window 

Status 
 

Playback 
Constraints 

Toolbar 
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When the four windows have been opened to their default locations, the screen will look 
something like the picture below. 
 
The only expected differences should be in the number and types of channels shown in the 
Channel Grid and the size of the media available. 
 

Channel 
Grid 

Recorder 
Control  

Status 
Log 

Recorded 
Time 

Classification 
Bar 
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Quick Start 1: A Simple Record and Playback Session 
 
Recording a session using the default values is as easy as hitting one button.  Do the factory 
default settings match what you really want to record?  Probably not, but that is easy enough to 
change.  We’ll give you those details later.  For now we’ll assume you like the defaults and are 
ready to go.  
 

 

To start a Record Session using the current channel and system configuration, simply 
select the Record button on the Recorder Control window or the toolbar.  Data will be 
recorded for each enabled channel to each enabled target. 

 

 

As data is recorded, Recorded Time will start to update, and Data Segments will be 
drawn in the right-hand portion of the Channel Grid, also known as the Data Grid.  
Disable and enable a particular channel by selecting its CHNL, T1, or T2 buttons.  The 
Data Segment for that channel will stop growing when the channel is disabled and a 
new Data Segment will start when the channel is enabled. 

 
 

Note regarding Record Enable button color: 

 When a button is… Then…  

 Blue  It is disabled and cannot be selected.  

 Gray  It has not been selected, but can be selected.  

 Orange  
It has been selected from within the GUI, but the Controller has 
not yet completed processing the request.  

 Yellow  

It has been selected, but the channel or media target is not 
currently able to record data due to the setting of some other 
companion button or the mode of the Recorder. 

 

 Green  It has been selected and is able to process incoming data.  

     
 

 

To stop the current Record session, select the Stop button on the Recorder Control 
window or the toolbar.  All data segments will be closed, time will stop updating, and 
the system will return to the Idle mode. 

 
 

 

To play back data from the just recorded session, select the Play button on the 
Recorder Control window or the toolbar.  Data channels are automatically mapped to 
play back using the same channel number on which they were recorded.  Playback will 
proceed to the end of the data file, stop, and return to the Idle mode. 

 
 
That’s it.  You’ve just recorded and played back a session on an IMUX G2 Chapter 10 Recorder. 
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Quick Start 2: P layback a Previously Recorded Session 
 
Practically, it is not that often that you need to play back the session that was just recorded.  
More likely than not, you will need to play back a session that was recorded some time in the 
past.  This Quick Start steps you through loading a Chapter 10 data file, mapping recorded 
channels to available output channels, and playing back the data. 
 
 

 

To open a Chapter 10 data file, select the Open Chapter 10 button on the toolbar or 
select File > Open Chapter 10 Data File. Use the window that pops up to browse to 
and select the desired Chapter 10 file. 

 

 

Once a file has been loaded, the Data Grid portion of the Channel Grid window will 
automatically set its focus on the Playback tab. 
 
In addition, the Record Enable Buttons segment of the Channel Grid will change to 
display Channel Mapping information. 
 
The channels that were recorded will be mapped into the available hardware playback 
channels in an iterative fashion. 
 

• First, a mapping will be made if there is a match between any recorded and 
available hardware playback channel numbers that have the same data type. 

 
• Second, of the remaining unassigned channels, the first channel listed in the 

TMATS header records will be assigned to the first available hardware 
playback channel of the same type. 

 
In addition, it is possible to use the drop-down lists to select which recorded data 
channel will be assigned to each available hardware playback channel. 
 
It is acceptable to have the same recorded channel assigned to multiple playback 
channels. 
 
It is acceptable to leave a playback channel unassigned.  In that case, no data will play 
back on that channel. 
 
Each drop-down list will be limited to the recorded channels that are the same type as 
the available hardware playback channel. 

 
 

 

To move to the beginning of the recorded data, simply select the BOD button on the 
Recorder Control window or the toolbar or select File > Transport > Beginning of Data. 

 
 

 

To play back data from the previously recorded session, simply select the Play button 
on the Recorder Control window or the toolbar.  Playback will proceed to the end of 
the data file, stop, and return to the Idle mode. 

 
That’s it.  You’ve just played back a Chapter 10 file on an IMUX G2 Chapter 10 Recorder. 
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Quick Start 3: Configuring a Channel 
 
When the application begins, all channels are configured based on the content of the default 
TMATS file.  It is possible to load a new configuration by opening another TMATS file. 
 

 

To open a TMATS file, simply select the Open TMATS File button on the toolbar or 
select File > Open TMATS Setup. Use the window that pops up to browse to and select 
the desired TMATS file. 

 
It is also possible to make changes to the channels from within the IMUX G2 GUI.  In order to 
do this, the Channel Grid window must be open. 
 
To change the channel name, select Channel Name and type in the new name.  The new text 
will only be saved when you hit <Enter>.  Leaving the field in any other manner will result in 
the changes being discarded. 
 
To open the Channel Setup 
screen for a particular channel, 
click on either of two places on 
the Channel Details portion of 
the Channel Grid: the Channel 
Number or the Channel Type. 
 

• The Channel Number 
 
 
• The Channel Type 
 
 
• The Channel Name 

 
 

Selecting the Channel Number or the Channel Type will bring up the Channel Setup screen.  
Depending on the channel type, the Channel Setup screen will look a little different.  However, all 
screens will have an OK and a Cancel button. 
 

 
 
Hitting OK will commit the changes for that particular channel including any changes made to 
any setup sub-windows for that channel, and close the setup window. 
 
Hitting Cancel will discard any changes made on that setup window and to any setup sub-
window for that channel and close the setup window. 
 
 
Note:  If a session has just been recorded, and a user opens the setup window for any channel, 

makes changes, and selects OK, then the session that was just recorded will no longer be 
available from the Record Target tabs in the Data Grid.  To play the session back, it will 
be necessary to open the data file and play it back from the Playback tab of the Data 
Grid. 
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That’s it.  You’ve just configured the channels on an IMUX G2 Chapter 10 Recorder. 

Quick Start 4: Selecting Media and Targets 
 
To understand how and where IMUX G2 data files are stored, it is necessary to first understand 
the concept of Media and Targets. 
 
 
A Media is a physical device with a drive letter that is accessible to the IMUX G2 Recorder.  It 
can be either a local or remote media as long as it has a drive letter associated with it. 
 
 
A Target is a directory on a media.  It is possible to have multiple Targets point to different or 
even the same directories on the same Media. 
 
 
Data files will be stored in the Target directory of the selected media using the Chapter 10 file 
naming convention. 
 

Selecting Media 

 

To view or make changes to the current Media settings, select Setup > Media 
Bandwidth. 
 
Use the drop-down options to select from the available media drive letters. 
 
Select OK to confirm the changes or Cancel to discard the changes. 

 

Selecting Targets 

 

To view or make changes to the current Target settings, select Setup > Targets 
 
Use the drop-down options to select from the media locations assigned in the previous 
step. 
 
For each Target, type in a path for recording, or browse to a preexisting path. 
 
Leaving the Target path blank will result in the target being disabled. 
 
Enter “\” to record to the root directory of the selected media. 
  
Select OK to confirm the changes or Cancel to discard the changes. 

 
 
That’s it.  You’ve just selected the storage location for your next Chapter 10 file recorded on an 
IMUX G2 Chapter 10 Recorder. 
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The Interface Explained 

The Application Window 
 
The IMUX G2 Graphical User Interface is built to take advantage of windowed application 
standards that are familiar to just about everyone.  When the application is started, it consumes 
the entire screen and will look something like the picture below.  We’ll get into the details of each 
portion of the screen in the sections that follow. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
What you will find is that many of the things you can do within the GUI can be done in multiple 
ways.  In order to find a quick summary of all of the shortcuts, be sure to check out Appendix 3 – 
Icons, Accelerators, and Hot Keys. 
 
For now, let’s explain the different elements of the GUI. 

Recorder 
Control  

Channel Grid 

Status Log 

Recorded 
Time 

Menu Bar  

Toolbar  

Status Tray 

Classification 
Bar 
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The Menu Bar 

 
 
The Menu Bar is there to give the user a list-based way of getting to a feature or performing a 
task.  A few things can only be done from the Menu Bar, such as saving of setup files, changing 
the system configuration, and viewing the Help features.  Just about everything else can be 
easily done using the toolbars or the sub-windows in the application. 
 
For a detailed description of what is available via the Menu Bar, check out the Menu Details 
section of this manual 
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The Toolbars 

 
 
There are four main Toolsets on the IMUX G2 GUI toolbar.  All of the functions accessible here 
are also accessible through the Menu Bar. 
 
 

File Toolbar 

 
 
The File toolbar has four main icons that allow you to quickly open and load configuration and 
data files.  The table below lists the title, the icon, any short cut keys, and a description of what 
the button will do. 
 

Title Icon Accelerator Hot Keys Task 

New 
 

Alt, F, N Ctrl + N 

Clear all current record and 
playback activity and return to 
same state as if the application was 
just started. 

Open TMATS Setup 
 

Alt, F, O Ctrl + O Open a TMATS file that will be used 
to configure the Record channels. 

Open Chapter 10 
Data File  

  

Open a prerecorded data set and 
display the data on the Playback 
tab of the Channel Grid.  When 
selected, the Channel Grid, if open, 
will make the Playback tab the 
active Data Grid. 

Open Channel Map 
 

  

Open a Channel Map file that 
assigns particular channel numbers 
from the current selected playback 
file to the current available 
hardware channels. 
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View Toolbar 

 
 
The View toolbar has four main icons that allow you to quickly open and close the primary 
application sub-windows.  The table below lists the title, the icon, any short cut keys, and a 
description of what the button will do. 
 

Title Icon Accelerator Hot Keys Task 

Recorder Control 
 

Alt, V, R  
Toggle the display of the Recorder 
Control window. 

Recorded Time 
 

Alt, V, T  
Toggle the display of the Recorded 
Time window 

Channel Grid 
 

Alt, V, G  
Toggle the display of the Channel 
Grid 

Status Log 
 

Alt, V, L  Toggle the display of the Status Log 

 
When a particular sub-window is being displayed, its related icon is shown with a tan 
background.  This can be seen in the Recorder Control icon on the toolbar of the screen shot at 
the top of this section.  In addition to the icon changing background color when it is activated, 
the related item on the View menu will have a checkmark displayed next to it. 
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Recorder Transport Control Toolbar 

 
 
The Recorder Transport Control toolbar has small icons that can be used for controlling the 
Record and Playback functions of the IMUX G2.  Because they are on the toolbar, they are 
always visible in the application, giving constant status of the state of the Recorder.  The table 
below lists the title, the icon, any short cut keys and a description of what the button will do. 
 

Title Icon Accelerator Hot Keys Task 

Beginning of Data 
 

Alt, T, B  
Set the Time Marker to the 
Beginning of Data location. 

Rewind 
 

Alt, T, W  
Set the Time Marker to a position 
that is one major tick mark’s worth 
of time prior to the current position. 

Stop 
 

Alt, T, S Ctrl + Q Stop the current record or playback 
activity. 

Play 
 

Alt, T, P Ctrl + P Playback from the current position. 

Fast Forward 
 

Alt, T, F  
Set the Time Marker to a position 
that is one major tick mark’s worth 
of time after the current position. 

End of Data 
 

Alt, T, E  
Set the Time Marker to the End of 
Data location. 

Event 
 

Alt, T, V Ctrl + V 

Insert an event marker during 
record.  Event markers will be 
stored in the Chapter 10 data file as 
Event Marker packets in accordance 
with the Chapter 10 specification. 

Monitor Data 
 

Alt, T, M Ctrl + M 
Clear the display and start 
monitoring the data that is available 
for recording. 

Record Data 
 

Alt, T, R Ctrl + R Clear the display and start 
recording to a new Chapter 10 file. 

 
* In the table above, an icon is not shown in Monitor Data mode because going into that mode is 
accomplished by right clicking on the Record Data icon. 
 
Each icon has four background colors that indicate how that icon can be used while the IMUX G2 
is in its current mode of operation. 
 

 A blue background shows that an icon is disabled and cannot be selected. 
 
 A silver background shows that an icon can be selected. 
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 An orange background shows that an icon has been selected and recognized by the GUI 

but not yet processed by the IMUX G2 hardware control software. 
 
 A green background shows that an icon has been selected, and the hardware is actively 

in the specified mode.  This is generally only seen when in Monitor, Record, or Playback 
modes. 

 
If the IMUX G2 is in playback mode, and BOD, REW, FF, or EOD are selected, playback will stop 
and the marker will move to the specified position. 
 
The icons on the Recorder Transport Control toolbar are kept in sync with the buttons in the 
larger Recorder Transport Control window and the selections found on the Transport menu.  
Making a selection in one place will cause all three locations to be updated. 
 
 

Playback Constraints (Shuttle) Toolbar 

 
 
The Playback Constraints (Shuttle) toolbar has icons that can be used for constraining the 
boundaries over which the IMUX G2 will play data back from a recorded session.  The table 
below lists the title, the icon, any short cut keys, and a description of what the button will do. 
 
When Use Constraints or Shuttle Playback 
are enabled, the background of the icon 
changes to green and the related item on 
the Shuttle menu will have a checkmark 
displayed next to it. 
 
 
When the IMUX G2 is in Record or 
Playback mode, it is not possible to make 
any changes to this toolbar.  The 
foregrounds of each icon will be grayed out. 
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Title Icon Accelerator Hot Keys Task 

Set Left Marker 
 

Alt, H, L Ctrl+Left 

Set the left marker to the current 
Time Marker position.  The box to 
the right of the icon will display 
the selected time. 

Set Right Marker 
 

Alt, H, R Ctrl+Right 

Set the right marker to the 
current Time Marker position.  
The box to the left of the icon will 
display the selected time. 

Use Constraints 
 

Alt, H, U Ctrl + U 

Toggle between using and not 
using the constraints during 
playback. 
 
When constraints are selected, 
the IMUX G2 will play back only 
the data that is found between 
the Left Marker and the Right 
Marker. 
 
If the Current Time Marker is at a 
position to the left of the Left 
Marker, playback will start from 
the current location and 
constraints will be applied once 
the Current Time Marker 
progresses past the Left Marker. 
 
If the Current Time Marker is to 
the right of the Right Marker, 
playback will start at the Left 
Marker. 

Shuttle Playback 
Enabled  

Alt, H, E Ctrl + E 

Toggle between continuous 
replay of the selected data 
segment or not. 
 
When Shuttle Playback is 
enabled, after the IMUX G2 has 
reached the end of the specified 
playback period, data playback 
will restart at the beginning of 
the specified playback period. 
 
Shuttle Playback can be enabled 
whether or not Constraints are 
being used. 
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The Classification Bar 
 

 
 
The Classification Bar, when enabled, shows the currently selected 
classification.  There is one exception.  If the Playback Data Grid is 
being displayed and a file has been loaded for playback, the 
Classification Bar will show the classification level of the previously 
recorded session.  If a session has been recorded and a Record Data 
Grid is being shown for that data, changing the classification will cause 
the data segments to be erased and the data to no longer be accessible 
from the Record Data Grids. 
 
To toggle the display, select View > Classification 
 
To change the classification, select Setup > Set Classification > (selection) 

 

The Status Tray 
 

 
 
The Status Tray provides system level status information when the IMUX G2 is in Record or 
Playback mode.  Details are reported for the current mode, the selected media, the PCI bus 
utilization, CPU utilization, and time information. 
 

System Mode Information 
 
The Mode display indicates the current mode of the recorder.  The table below provides details 
on how this indicator operates. 
 

Mode Icon State 

Idle  Steady 

Monitor  
 

Flashing 

Record  
 

Flashing 

UNKNOWN 
UNCLASSIFIED 
CONFIDENTIAL 

SECRET 
TOP SECRET 

OTHER 
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Mode Icon State 

Play  
 

Flashing 

 

System Status Information 
 
The Media X segments display status information for the particular predefined media. 
 

 Amount of space currently available on the media 
 
 % of the media space that is currently remaining 

 
 % of allocated Media Bandwidth being used by IMUX G2 

 
For example: Media 1: 198GB (83%) 15% means that Media 1 currently has 198 gigabytes 
of space available on it, which equates to 83% of the total media capacity, and currently the 
IMUX G2 is transferring to that media at 15% of its allocated rate.  See the details elsewhere in 
this document for setting Media Bandwidth. 
 
The PCI display shows % of allocated PCI bandwidth being used by the IMUX G2.  See the 
details elsewhere in this document for setting the allocated PCI Maximum Bandwidth. 
 
The CPU display shows the % of total CPU utilization for the entire system. 

Time Channel Status Information 
 
The two elements on the right-hand side of the Status Tray are related to recorded time. 
 
When the system is idle, the display will look like this:  

 
 
While in Record/Monitor mode, the display may look something like this: 

 
 

 The numeric value will show the current actual or freewheeling IRIG time of the IRIG 
Time Input channel. 

 
 The LED displays will show whether or not the input is in lock with an IRIG Time Source. 
 

o A green LED indicates that the time channel is in lock. 
 
o A red LED indicates that the time channel is out of lock. 
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While in Playback mode, 
 

 The time display will show the current time being reproduced. 
 
 A green LED indicates that the circuit was in lock when it was recorded. 

 
Position the cursor over the IRIG Time Input Channel LEDs to bring up Tool Tip windows that 
display channel status information.  All status information for these LEDs is cumulative in nature. 
 

IRIG Time Input Channel Green Status LED Details 
Display Status Meaning 

 

Input The total number of time packets received from the hardware while in 
Record/Monitor mode. 

Output The total number of time packets sent to the hardware while in 
Playback mode. 

Lock The total number of times the GUI requested status from the Controller 
and the status was reported as being in IRIG Lock.  Since the GUI 
updates approximately 7 times per second, this number will increase 
much more rapidly than the total packet count numbers. 

 
IRIG Time Input Channel Red Status LED Details 

Display Status Meaning 

 

OF Overflow – While in Record/Monitor mode, the total number of times 
the hardware provided data faster than software was able to process it 
and data was dropped in order to catch up. 

UF Underflow – While in Playback mode, the total number of times the 
software was not able to provide data quickly enough for it to be 
properly reconstructed by the hardware. 

CS Checksum – While in Record/Monitor mode, the total number of times 
the controller evaluated the packet received from the hardware and 
found a checksum error.  While in Playback mode, the total number of 
times the hardware evaluated the packet received from the software 
and found a checksum error. 

SS SoftSync – While in Playback mode, the total number of times the 
hardware was not able to find the sync pattern at the expected start of 
the next Chapter 10 data packet. 

Search The total number of times the GUI requested status from the Controller 
and the status was reported as being in IRIG Search.  Since the GUI 
updates approximately 7 times per second, this number will increase 
much more rapidly than the total packet count numbers. 

Check The total number of times the GUI requested status from the Controller 
and the status was reported as being in IRIG Check.  IRIG Check 
condition occurs when the channel has found the IRIG Sync pattern 
and is currently evaluating the data to determine whether or not it truly 
is in sync.  Since the GUI updates approximately 7 times per second, 
this number will increase much more rapidly than the total packet 
count numbers.  
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Although the IMUX G2 Recorder uses IRIG-A/B/G day format during recording, it is able to play 
back other time packet formats with the following restrictions: 
 

• Real Time Clock time data packets are played out as an IRIG-B time signal, and the 
packets are decimated when necessary to one per second 
 

• Month, Day, Year format packets are converted to day only format packets prior to 
playback 
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The Main Window  

Recorder Transport Controls 
The Recorder Transport Controls are simply bigger, easier to see versions of the icons on the 
Recorder Transport Controls toolbar.  Rather than repeat the details here, we’ll simply provide a 
few screen shots of how the controls should look in different operational scenarios.  Remember, 
any button clicks done here will cause the icons on the toolbar and the items on the Transport 
menu to be updated accordingly. 
 
The screenshot below shows the IMUX G2 in Idle mode. 
 

 
 
 
The screenshot below shows the IMUX G2 in Monitor mode.  To enter Monitor mode using the 
Transport Controls, left click on the MON button. 
 

 
 
 
The screenshot below shows the IMUX G2 in Record mode.  To enter Record mode using the 
Transport Controls, left click on the REC button.  It is not possible to go back into Monitor mode 
from Record mode. 
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The screenshot below shows the IMUX G2 in Record mode in a situation where the Stop 
button on the GUI has been selected, but the command has not yet been processed by the IMUX 
G2 hardware control software. 
 

 
 
The screenshot below shows the IMUX G2 in Playback mode. 
 

 
 
 

Recorded Time 
 
When the system is in Record mode, the 
Recorded Time display will show the time 
currently being recorded. 
 
If the background is green, it means that the 
Recorder is in lock with an external time 
source. 
 
If the background is gray, it means that the Recorder is not in lock with an external source and is 
freewheeling. 
 
When the system is in Playback mode, the Recorded Time display will show the time that is 
currently being generated by the Time channel.  The display is always green when generating 
Time data. 
 
When the system is in neither Record nor 
Playback mode, the display background is 
gray, and the display is filled with dashes. 
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Channel Grid 
The Channel Grid is where all of the channel specific record and playback session configuration 
and monitoring tasks are done.  It is broken up into five main sections, only four of which are 
viewable at any one time. 
 
The five sections are: Status, Channel Details, Record Enable, Channel Mapping, and the Data 
Grid.  Status, Channel Details, and the Data Grid are always available.  What is displayed 
between the Channel Details and the Data Grid is a function of which tab is selected in the Data 
Grid. 
 
The Record Enable Button window is displayed when the Data Grid is set to the Record Target 
1, Record Target 2, Ethernet or optional OMEGA tab. 
 

 
 
 
 
The Channel Mapping window is displayed when the Data Grid is set to the Playback tab. 
 
 

 
 
The number of channels that are displayed on the Channel Grid is a function of the number of 
channels installed and defined in the hardware configuration file.  If channels are defined but not 
installed, the Channel Details will be grayed out. 

Status Channel Details Record Enable Data Grid 

Channel Mapping 
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Channel Grid Title Bar 
The Channel Grid Title Bar includes path information for the data being recorded or played back.  
The target information that is displayed depends on which Data Grid tab is selected.  In Record 
mode, the Channel Grid will include the path details for the file that is being recorded. 
 

 
 
When recording is terminated the complete file name for the file will be displayed. 
 

 
 

Channel Status 
The leftmost section of the Channel Grid displays Channel Status information.  The top red and 
green LED displays are summary displays that show combined status for all channels in the 
system.  If the red LED display is lit for any channel, the summary LED display will also be lit.  If 

the green LED display is lit for all enabled channels, the summary LED 
display will also be lit. 
 
A lit green LED display shows that some amount of data flowed 
between the hardware and software since the last update was made to 
the status. 
 
An unlit green LED display shows that there was no data flow. 
 
A lit red LED display shows that there was an error of some type since 
the last update was made to status. 
 
An unlit red LED display shows that there was no error of any type. 
 
Channel Status is updated approximately 7 times per second. 
 
Position the mouse cursor over either of the Channel Status LEDs to 
bring up Tool Tip windows that display channel status information.  
Updates to the status values are made approximately seven times per 
second. 
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Data Channel Green Status LED Details 
Display Status Meaning 

 

Input The total number of data packets received from the hardware while in 
Record/Monitor mode. 

Output The total number of data packets sent to the hardware while in 
Playback mode. 

DF? Data Flow – “True” when there has been at least one data packet 
transferred in either direction between the hardware and the controller 
software since the last status update.  Otherwise it is set to “False.” 

 
Data Channel Red Status LED Details 

Display Status Meaning 

  

OF Overflow – While in Record/Monitor mode, the total number of 
times the hardware provided data faster than the software was 
able to process it and data was dropped in order to catch up. 

UF Underflow – While in Playback mode, the total number of times 
the software was not able to provide data quickly enough for it 
to be properly reconstructed by the hardware. 

CS Checksum – While in Record/Monitor mode, the total number 
of times the controller evaluated the packet received from the 
hardware and found a checksum error.  While in Playback 
mode, the total number of times the hardware evaluated the 
packet received from the software and found a checksum error. 

SS SoftSync – While in Playback mode, the total number of times 
the hardware was not able to find the sync pattern at the 
expected start of the next Chapter 10 data packet. 

BSLK? Bit Sync Lock – While in Record/Monitor mode, for PCM 
channels with Bit Syncs enabled, the In-Lock status of the Bit 
Sync.  True means the status is In-Lock.  False means that 
status is NOT In-Lock.  For PCM boards with a revision less 
than B60 the board does not provide the necessary details and 
the indicator will always show that the board is out of lock 
regardless of the true state of the Bit Sync. 

MnFr Minor Frame Status – While in Record/Monitor mode, for PCM 
channels setup for Packed mode, this will show the minor 
frame status.  Search means the frame sync pattern can not be 
found in the current data.  Check means that the frame sync 
pattern has been found in the current data and that more 
instances are required to satisfy the Matches to Lock criteria.  
Lock means the Matches to Lock criteria have been satisfied 
and the frame sync pattern continues to be found in the data. 

MjFr Major Frame Status – While in Record/Monitor mode, for PCM 
channels setup for Packed mode, this will show the major 
frame status.  Search means a valid subframe counter value 
can not be found in the current data.  Check means that the 
valid subframe counter has been found in the current data and 
that more properly incrementing/decrementing instances are 
required to satisfy the Matches to Lock criteria.  Lock means 
the Matches to Lock criteria have been satisfied and properly 
incrementing/decrementing values continue to be found in the 
data. 
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Channel Status Information 

 
The Channel Status section of the Channel Grid can be expanded to display additional 
status information if the PCM boards in the system have been upgraded to provide 
expanded status (revision BM0 or higher). Use the » button on the right-hand side of the 
Status header to expand or collapse the Channel Status section.  When expanded, lock 
status information will be displayed for each PCM channel. 
 
Just to the right of the LEDs are lights for bit sync lock status, minor frame lock status 
and major frame lock status.  The bit sync status will only be available for those channels 
that have a bit sync installed and enabled.  The minor and major frame lock status will 
be available for channels configured to use Packed Mode Data on boards at revision BM0 
or higher, and channels configured to use Throughput Data with the framing information 
setup on boards at revision BN0 or higher. 
 
To the right of the lock status lights are counters that display the total number of minor 
frame lock, minor frame check, major frame lock and major frame check occurrences.  
Counts will be available for channels configured to use the Packed Mode Data on boards 
at revision BM0 or higher, and channels configured to use Throughput Data with the 
framing information setup on boards at revision BN0 or higher. 
 
Updates to the lock status information are made approximately seven times per second.  
The lock status information is only available while in Record/Monitor mode. 
 



IMUX G2 – CHAPTER 10 REC0RDER  USER GUIDE 2.8p2 

27 
 

Channel Details 
The second section of the Channel Grid always contains the Channel Details.  There are four 
columns in the Channel Details section. 
 
The Channel column contains the channel number of the hardware device.  This number is a 
reference to both the physical input channel and the associated physical output channel.  These 
Channel Numbers cannot be changed from within the GUI. They are set up using an XML 
hardware configuration file. 
 
The Type column references the type of channel that is installed.  This is a function of the 
hardware installed in the IMUX G2.  These display fields also serve as buttons used for bringing 
up the Channel Configuration windows. 

 
To get to the Channel Configuration 
windows, click on the Channel Number or 
the Channel Type.  It is possible to view 
the Channel Configuration windows while in 
the Record or Monitor mode, but it is not 
possible to make modifications. 
 
The Name column refers to the Channel 
Name that will be used to describe the 
channel in the Chapter 10 file.  The default 
value is automatically determined by 
concatenating the text “DataLink" and the 
channel number.  This default name will be 
updated from the TMATS file if there is an 
associated record found in the file.  It is also 
possible to change the name manually. 
 
 

To change the name of the channel, click on the Channel Name and enter the desired text.  
The text change is saved when exiting the field.  Hit the <Esc> key to cancel the changes.  It is 
only possible to change the Channel Name when in Idle mode. 
 
The Activity meter is a sample driven display that provides a quick look into the data content of 
a particular channel.  The table below explains how the activity is determined. 
 

Channel Type Activity Density (Range 0-31) 

1553 This value is modulus 32 of the number of 1553 packets received.  It is 
reset to “0” if no packets are received for one second. 

Analog The number of bits set to “1” in the first 32-bit word of each packet. 

Analog Audio The value of first audio sample in the packet scaled from 0 to 32. The data 
is stored in two’s complement so no activity shows up as 50%. 

429 This value is modulus 32 of the number of 429 packets received.  It is reset 
to “0” if no packets are received for one second. 

Ethernet This value is modulus 32 of the number of Ethernet packets received.  It is 
reset to “0” if no packets are received for one second. 

PCM The number of bits set to “1” in the first 32-bit word of each packet. 

Serial-UART The value of the first byte in the packet divided by 8. 
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Channel Type Activity Density (Range 0-31) 

Video The value of the first 32 bit video word in the packet divided by 134217728 

Snapshot Viewers 
For some channel types, the Activity meters also serve as buttons to bring up a Snapshot 
Viewer.  A Snapshot Viewer allows a user to capture a snippet of incoming data and display it 
on the screen.  Because a Snapshot Viewer requires data, it can not be viewed while running in 
Simulation mode.  Snapshot Viewers are available in Record, Monitor, and Playback modes. 
 
Currently, Snapshot Viewers are available for Analog, Analog Audio, and PCM data. 

Analog Snapshot Viewer 
The Analog Snapshot Viewer collects and displays 100,000 samples of the selected channel 
without interrupting current data recording.  The primary purpose of the Analog Snapshot Viewer 
is to provide the operator quick confirmation that the data is being properly received and 
interpreted by the channel. 
 
To open an Analog Snapshot Viewer, click on the Activity Meter for the desired Analog 
channel. 
 

 
 

Analog Snapshot Viewer Toolbar 
The Frequency and Word Size details that are displayed are informational only. 
 
Select Refresh to collect another 100,000 samples of analog data. 
 
Left click on the data to zoom in.  Hold down the <Ctrl> key and left click on the data to zoom 
out. 
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Analog Snapshot Controls 
To zoom in, move the mouse cursor over the desired center point and left click. 
 

 
 
Position the cursor over a point to cause an information box to pop up and display the time of 
the event and the value. 
 
To select a span of data, move the mouse cursor over the desired center point, click and hold the 
left mouse button, drag the cursor to the desired end point, and release.  To zoom in on this 
selection, move the mouse cursor over the selection and left click. 
 

 
 
To zoom out, move the mouse cursor over the desired center point, hold down the <Ctrl> key 
and left click. 
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Analog Audio Snapshot Viewer 
The Analog Audio Snapshot Viewer collects a snippet of audio data and allows the snippet to 
be played back through the system audio channels without interrupting current data recording.  
The primary purpose of the Analog Audio Snapshot Viewer is to provide the operator quick 
confirmation that the data is being properly received and interpreted by the channel. 
 
To open an Analog Audio Snapshot Viewer, click on the Activity Meter for the desired Audio 
channel.  The Snapshot Viewer will open and collect data for five seconds.  When the data is 
collected, it will be displayed. 
 

 
 

Audio Snapshot Viewer Toolbar 
To play the snippet of captured Audio data, select Play on the Audio Snapshot Viewer toolbar. 
 
To stop playing the snippet, select Stop on the Audio Snapshot Viewer toolbar. 
 
The Frequency and Word Size details that are displayed are informational only. 
 
Select Refresh to collect another five seconds of audio data. 
 
Left click on the data to zoom in.  Hold down the <Ctrl> key and left click on the data to zoom 
out. 
 

Audio Snapshot Controls 
To zoom in, move the mouse cursor over the desired center point and left click. 
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Position the cursor over a point to cause an information box to pop up and display the time of 
the event and the value. 
 
To select a span of data, move the mouse cursor over the desired center point, click and hold the 
left mouse button, drag the cursor to the desired end point, and release.  To zoom in on this 
selection, move the mouse cursor over the selection and left click. 
 

 
 
To zoom out, move the mouse cursor over the desired center point, hold down the <Ctrl> key 
and left click. 
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PCM Snapshot Viewer 
The PCM Snapshot Viewer collects a snippet of PCM data and soft decommutates it for display 
on a grid.  The primary purpose of the PCM Snapshot Viewer is to provide the operator quick 
confirmation that the data bits are being properly received and interpreted by the channel.    The 
PCM Snapshot Viewer currently works with fixed word length/fixed frame length formats and is 
limited to 65,535 total words per frame.  The PCM Snapshot Viewer can only be activated for a 
PCM channel that is configured in Throughput mode. 
 
To open a PCM Snapshot Viewer, click on the Activity Meter for the desired PCM channel.  The 
PCM Snapshot Viewer will open, and all fields will be blank.  The first thing that must be done is 
to enter the PCM framing information on the toolbar.  Each time the application is started all 
snapshot viewer history is lost.  However, once the details have been filled in for a particular 
channel, the information will be retained as long as the G2 application is running. 
 

 
 
The Frame Sync is entered in hexadecimal.  A leading “0x” is allowable and will be ignored if 
included.  Alphabetical characters can be entered in either upper or lower case.  If the Frame 
Sync size is not an integer multiple of four (4) then the unused most significant bits of the left 
most hexadecimal character must be zero (0).  For example, if the Frame Sync size is 33 bits, the 
leading character can be either zero (0) or one (1).  If any other character is entered an error 
message will be posted asking the user to correct the frame geometry. 
 
The FS Length is the Frame Sync length and specifies the number of bits in the Frame Sync field 
that are valid.  If FS Length is set to zero (0) when the user enters a Frame Sync pattern, the FS 
Size will be automatically calculated using the assumption that all bits are valid.  If FS Length has 
any other value that value will not be changed when the Frame Sync pattern is changed.  Enter 
the value directly, or use the up arrow to increment or the down arrow to decrement the current 
value.  The Frame Sync Length must be an integer multiple of the Word Length. 
 
The Word Length is the number of bits in each standard data word.  Enter the value directly, or 
use the up arrow to increment or the down arrow to decrement the current value. 
 
The Words/Frame is the total number of standard data words in the frame.  This number must 
include one word for the Frame Sync regardless of the size of the Frame Sync pattern.    Enter 
the value in directly, or use the up arrow to increment or the down arrow to decrement the 
current value.  A note to OMEGA users, OMEGA projects do not count the Frame Sync as one 
word regardless of size.  If using setup information from OMEGA projects, be sure to adjust the 
Words/Frame to account for this difference. 
 
The Bit Order identifies whether the bit order of the words is Most Significant Bit (MSB) first or 
Least Significant Bit (LSB) first.   Use the drop-down box to select the correct value. 
 
Current limitations for the PCM Snapshot Viewer are as follows… 

1. All words must be the same word length. 
2. The Frame Sync size must be an integer multiple of the word length. 
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When all frame formatting information has been entered, select Refresh to gather and to soft 
decommutate fresh data.  As data is being collected, the words “Waiting for Data” will be 
displayed in the data section. 
 
If the PCM Snapshot Viewer is not able to find Frame Sync lock in the current data set, it will 
display the message “OUT OF LOCK” in the data section. 
 
To decommutate the same set of data using a different frame format, make the desired 
modifications to the fields on the toolbar and select Recalculate. 
 
To gather and evaluate new data using the same frame format, select Refresh. 
 
Example of a populated PCM Snapshot Viewer: 
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Record Enable Buttons 
The Record Enable Buttons window is displayed when the Data Grid is set to any tab other than 
the Playback tab.  The number of columns in this section will vary based on the features installed 
in the recorder. 
 

 CHNL is simply a channel enable button.  This must be selected in order for channel 
data to be monitored or sent to any Target. 

 
 T1 and T2 refer to Media Target 1 and Media Target 2.  These must be selected in order 

for the channel to be included in the data stream in the location specified in the Target 
settings. 

 
 E# refers to a UDP network data distribution feature.  The “E” specifies the type of 

target.  The “#” is an integer that specifies a unique numeric identifier for each target in 
the system.  If there is no network interface hardware installed, the column will not 
appear. 

 
 O# refers to a direct connection to OMEGA using the Powered By OMEGA feature.    

The “O” specifies the type of target.  The “#” is an integer that specifies a unique 
numeric identifier for each target in the system.  If PBO is installed on the system, an 
“O#” target will be available.  If PBO is not installed on the system, there will be no 
column for an “O#” target. 

 

 
 
 
Each button on the window can be one of four colors 
 

 A blue background shows that an icon is disabled and cannot be selected. 
 
 A silver background shows that an icon is not currently selected but can be. 
 
 A yellow background shows that an icon has been selected, but because of another 

setting, no data will flow from the hardware to the software for storage on the selected 
Target. 
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 A green background shows that a channel has been enabled, the target has been 

selected, the hardware is actively in Record mode, and the channel is now able to pass 
data to the software. 

 
In the screen shot above, note that the CHNL button of Channel 81 and the T1 and T2 buttons 
of Channel 82 are lit yellow. 
 

 Channel 81: Because the channel is enabled but no Targets are selected, it can work in 
Monitor mode, but no data will be stored even if the unit is placed in Record mode. 

 
 Channel 82: Because the channel is not enabled, even though Targets are selected, it will 

not work in Monitor mode and it will not contribute data to the data file even if the unit is 
placed in Record mode. 

 
It is also possible to completely disable and re-enable all data being transmitted to a Target.  
Using the mouse cursor, Left Click on a Target’s Column Header (T1, T2, E3, O4) to turn the 
target on or off. 
 
When a Target is turned off the header text will remain bold, but all of the channel specific 
enable buttons will turn blue.  When a Target is turned on, each channel specific enable button 
will return to its original state. 
 
When a Media Target (T1 or T2) is turned off, it will close the current recording.  When a Media 
Target (T1 or T2) is turned back on, it will start a completely new recording session to that target 
and the data grid for that Target will be reset. 
 
If there is an error recording to one target it will not affect recording to the other targets.  For 
example, consider the case where T1 is connected to a network drive and T2 is connected to a 
local drive.  If the network connection to T1 is unplugged, T1 will fail, overflow, and eventually 
turn itself off.  T2 will continue with no errors or dropouts. 
 
Note that if two targets are sharing the same media, both targets may fail because of a common 
media issue. 
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Channel Mapping 
The Channel Mapping window is displayed when the Data Grid is set to the Playback tab.  If an 
Ethernet Target has been defined, two columns will be displayed for each channel.  If no 
Ethernet Target has been defined then there is only one column for each channel. 
 
When a data file is loaded, the system will attempt to automatically route recorded source 
channels to a particular playback channel.  Matches are made in the following priority. 
 

 One for one mapping based on identical channel number. 
 
 Lowest remaining source channel to lowest remaining compatible playback channel. 

 
Another method is to pick a particular source channel to recreate on a Playback channel.   
Source Channels will only show up in the drop-down menu for a Playback channel if they are a 
compatible type. 
 
Select the combo box drop-down button to see the available channels.  The channel descriptions 
in the drop-down box include a counter, followed by the source type, followed by the source 
channel number. 
 
Select the blank line to prevent the channel from playing any source. 
 
It is possible to have two playback channels assigned to playback the same recorded channel. 
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If an Ethernet Target has been defined and 
enabled, an additional channel mapping column is 
displayed next to the Playback Source column.  It is 
identified as the letter “E” followed by a target ID, 
for example “E5”.  By default, all mapped channels 
are disabled for Ethernet output and they must be 
specifically enabled.  The one exception is the 
primary time channel, which is not displayed for 
mapping and will be output even if no other 
channels have been selected.  

 
In cases where a single source channel is mapped 
to multiple output channels, if Ethernet output is 
enabled on any of the related channels, only one copy of the packets will be broadcast via UDP, 
regardless of how many of the Ethernet output enable buttons have been selected. 
 
If PBO is installed on the system, an additional channel mapping column is displayed next to the 
Ethernet Target column. It is identified as the letter “O” followed by a target ID, for example 
“O7”.  By default, all mapped channels are disabled for PBO output and they must be specifically 
enabled. The one exception is the primary time channel, which is not displayed for mapping and 
will be output even if no other channels have been selected 
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Data Grid 

 
 
The Data Grid is a graphical representation of the record session over time.  It allows easy 
viewing of which channels were enabled for which portion of the session.  This allows the user to 
easily identify data segments of interest and choose which portions of a session to play back, 
validate, or analyze.  Right clicking the mouse will bring up a menu that provides quick and easy 
access to the tools. 
 
The number of tabs on the Data Grid is a function of the number of targets defined in system 
configuration file.  There will always be a Playback tab. Tabs for Record Target 1, Record Target 
2, Ethernet, and OMEGA will be displayed only if they are included in the system configuration.  
Each tab is managed independently, but only one tab is viewable at a time. 
 
Record Target 1 shows the status of the current record session on Target 1 as defined on the 
setup pages.  Likewise, Record Target 2 shows the status of the current record session on Target 
2 as defined on the setup pages.  The Ethernet tab will show record status to a TCP/IP client.  
The OMEGA tab will show record status of data sent to OMEGA SERV software via a Powered By 
OMEGA (PBO) connection. 
 
For all record tabs, immediately following a record session the display will retain the graphical 
representation of the session.  It is possible to play back data from Media Target 1 and Media 
Target 2 for the last recorded session.  However, if the application is closed, a new recording 
session is started, or the hardware is reconfigured, the display will be cleared.  Once the display 
is cleared, it will be necessary to switch to the Playback tab and open the recorded Chapter 10 
Data File in order to view and play back the recorded data. 
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Time Ruler 

 
 
Under the tabs and above the data segments is a Time Ruler.  Time is indicated at every major 
tick mark.  Time can be shown as either Recorded or Relative time.  To change the Time Ruler 
format from the Data Grid display, right click on the Time Ruler, select Time Ruler Format, and 
select the desired format. 
 
The major tick marks on the Time Ruler are calculated based on the initial time value when 
recording started and are incremented assuming a linear extrapolation of time that is exactly one 
second per 10,000,000 ticks of the Chapter 10 Counter.  In both Record and Playback modes, the 
initial value is based on the first recorded IRIG time value. 
 

 
 
When Recorded Time is selected, the ruler will show the actual time information that was 
recorded.  This works most of the time, but it can be a problem if there was an incorrect or 
unstable IRIG Time source.  In these cases, it may be necessary to switch to Relative Time.  In 
Relative Time mode, the left hand side of the display is considered to be day 000 – 
time 00:00:00.  Major tick marks are then established based on the Chapter 10 counter 
regardless of any time information that was recorded. 
 

 
Note:    When displaying the Playback Data Grid, if the counter value for the last time packet is 

off by greater than 1% of a time period from the calculated Chapter 10 Counter value for 
that time; the display will automatically switch to Relative Time.  For example… 

  
Start time packet shows time 010-12:34:56:000 and counter value 10,000,000 

 
Last time packet shows time 010-12:36:36:000 and counter value 1,010,200,000 

 
Based on the start packet and assuming 10,000,000 clock ticks per second, the last time 
packet should have a counter value of 1,010,000,000.  The delta of 200,000 is 2% and 
exceeds the 1% limit.  The display will automatically switch to Relative Time. 
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Whether displaying Recorded Time or Relative Time, it is possible to change the resolution of the 
Time Ruler and the Data Segment displays in the Data Grid.  To change the Time Ruler Format 
from the Data Grid display, right click on the Time Ruler, select Zoom, and select the desired 
time resolution. 
 
In Record and Playback mode, if there is too much data to display for the resolution selected, the 
Zoom will adjust to the lowest possible resolution that properly displays all of the data set 
information. 
 
In Idle mode it is possible to zoom to any level.  However, it may not be possible to view all data 
at the higher zoom level.   
 

 
 
It is possible to change the Time Ruler Format and the Zoom level during Record and Playback as 
well as when in the Idle mode. 
 
The settings are different for each tab and are remembered even if the application is closed. 
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Zoom Buttons 

 
 
In addition to using the Right Click toolbar or the menu selections, it is possible to use the 
magnifying glass icons in the bottom right hand corner of the Data Grid to change the Zoom level 
of the Data Grid display. 
 

 
Select the “+” magnifying glass to zoom in to a higher time resolution view of the data 
segments and show greater detail. 

 
Select the “–” magnifying glass to zoom out to a lower time resolution view of the data 
segments and see the bigger picture. 

 

Left and Right Constraint Markers 
 
 
On the Time Ruler are two green triangles.  They are dark green when 
the Use Constraints feature is disabled.  They are bright green when the 
Use Constraints feature is enabled.  The picture to the right shows them 
enabled.  It is possible to move a marker by dragging it.  To do so, left 
click on it and drag it to the desired position. 
 
For the left hand marker… 

 
• Dragging it past the beginning of data will cause the marker to be snapped to the 

beginning of data. 
 
• Dragging it past the right hand marker will cause the right hand marker to also be moved 

to the right.  If there is enough data remaining, the right hand marker will be moved so 
that the spacing remains the same as it was before the move.  If there is not enough 
data remaining, the right hand marker will be moved to the end of data. 

 
For the right hand marker… 

 
• Dragging it past the end of data will cause the marker to be snapped to the end of data. 
 
• Dragging it past the left hand marker will cause the left hand marker to also be moved to 

the left.  If there is enough data remaining, the left hand marker will be moved so that 
the spacing remains the same as it was before the move.  If there is not enough data 
remaining, the left hand marker will be moved to the beginning of data. 
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Current Time Marker 
 
 
Running from the top to the bottom of the data grid is a yellow line 
with a red outline called the Current Time Marker.  During Record and 
Playback this marker shows the current position in the data file.  When 
in idle mode, this marker shows where playback would start. 
 
To move the Current Time Marker, left click on the Time Ruler.  The 
Current Time marker will move to the selected time and the Data Grid 
will be redrawn to place the Current Time Marker in the middle of the 
display window. 

 

 

 
 

Event Marker 
 
When a file is loaded for playback on the Playback grid, the first 32 Event Markers found in the 
file will be displayed on the Time Ruler.  To identify event details, hover over the yellow event 
marker of interest. 
 

 



IMUX G2 – CHAPTER 10 REC0RDER  USER GUIDE 2.8p2 

43 
 

Right Click Options 
 
There are several right-click options available for each data segment in the Data Grid display. 
 
Set Playback 
Constraints will set 
the playback 
constraints to match 
the beginning of data 
and the end of data 
for the current data 
segment.  Selecting 
this does not change 
whether or not Use 
Constraints is 
enabled. 
 
Play in OMEGA-FILE 
will open the OMEGA-
SERV software 
application and allow 
the user to view and play back the Chapter 10 data file as if at a real-time Telemetry Data 
Processing Ground Station.  This does require that project be defined within OMEGA-SERV.  
Review the OMEGA-SERV File Playback help files for additional details on how this works. 
 
Analyze in ODE will open the ODE Desktop software application and allow the user to analyze the 
data stored in the Chapter 10 data file.  This does require an applicable OSPROJ file and 
supposes that the data set has already been manually published within ODE Publisher or was 
automatically published by ODE during data collection.  Review the ODE help files for additional 
details on how this works.  It is possible to change whether this button will start the ODE 
Publisher or the ODE Desktop application.  To establish which one, place a shortcut to the ODE 
application in the directory C:\Chapter 10 File Analysis Tools and name the shortcut “Start ODE.” 
 
If OMEGA-SERV or ODE are not installed an information box will pop up advising the user of the 
need to install the appropriate software.  Contact Telemetry and Data Systems for more details 
on acquiring OMEGA products.  
 
View Chapter 10 File opens a Chapter 10 file viewer of your choice.  To establish the viewer, 
place a shortcut to the Chapter 10 file viewer program in the directory C:\Chapter 10 File Analysis 
Tools and name the shortcut “Start Ch10 Packet Viewer.”  This will bring up the viewer and allow 
you to select the Chapter 10 file of interest. 
 
View TMATS Header opens a TMATS file viewer of your choice.  To establish the viewer, place a 
shortcut to the Chapter 10 file viewer program in the directory C:\Chapter 10 File Analysis Tools 
and name the shortcut “Start TMATS File Viewer.”  This will bring up the viewer and allow you to 
select the TMATS file of interest. 
 
Export will create a new Chapter 10 file.  This file will include a revised TMATS header packet 
that eliminates all information from unselected channels, all time channel packets, and only the 
data packets for the selected channel. 
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Channel Configuration 
To review or make changes to the configuration of a data channel, it is necessary to left click on 
the Channel Number, the Channel Type, or the Channel Name within the Channel Details section 
of the Channel Grid.  This will bring up a Setup window that is specific to the channel type. 
 
The title bar of the new configuration window will include the corresponding channel type, the 
channel number, and the channel name for the channel selected. 
 
To change the configuration of a channel for the next recording, the Data Grid must be open and 
must be displaying any tab except the Playback tab. 
 
If a channel configuration window is opened when the Data Grid is displaying data on the 
Playback tab, it is only possible to make changes to the output channel. 
 
To see the setup information for a 
prerecorded channel, the recorded 
channel must be mapped to a playback 
channel.  Then, while the Playback tab is 
still selected, open the channel 
configuration and review the input 
options.  All input fields will be grayed 
out but will still be viewable.  If a 
channel is not mapped, the user will 
receive notice that no setup information is 
available. 
 

 
 
 

For all channel types, each window will have an OK and a Cancel button.  Selecting Cancel will 
discard all changes made to all configuration windows that are subordinate to the current 
window.  For example, selecting Cancel on the PCM Setup page will discard all changes made to 
the PCM Input Setup page, even if the user had selected OK on the PCM Input Setup page. 
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Analog Channel Configuration 
 
The main Analog Setup window allows for setting the sample rate and filter settings for each 
Analog channel. 
 

 
 
It also allows the user to bring up sub-windows used to set up the Signal Level and Packet 
Format setting for the Analog Input and the Signal Level for the Analog Output. 
 
Use this screen to change the sample rate and to select whether any filters are to be applied to 
the input and output signals. 
 
Select the Analog Input button to open the Analog Input Setup window. 
 
Select the Analog Output button to open the Analog Output Setup window. 
 
Select OK to commit the changes and close the window. 
 
Select Cancel to discard the changes to this channel and close the window. 
 
The Analog Channel Setup screens also has <<Prev and Next>> buttons to allow quick 
maneuvering to the setup screens for the other channels in the system.  If any changes have 
been made to the channel setup, when selecting either of these buttons, it is the same as hitting 
the OK button, committing any changes, and opening the setup window for another channel. 
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Setting the Input and Output Filters 
The input and output filters can be set using 
the filter dropdown menus available on the 
main Analog Setup menu.  Select the filter 
bandwidth of choice. 
 
The default value for the Input Filter is ‘No 
Filter’.  It is highly recommended that this 
setting not be used and that the lowest 
acceptable filter selection be used. 
 
The default value for the Output Filter is ‘As Recorded’.  With this setting, if an input filter was 
selected during recording, during playback the output filter will automatically be set to the same 
setting as the input filter. 
 
Changing the Output Filter setting for a channel causes that change to be applied to all playback 
operations regardless of which Data Grid tab has been selected.  For instance, changing the 
Output Filter for a channel to “1 MHz” while the Record Target 1 tab is selected will also mean 
that the Output Filter for that channel will be “1 MHz” when playing back from the Playback tab. 
 
Filters are not applied to the output signal when operating in Record or Monitor mode with Data 
Loop Thru Enabled. 
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Analog Input Setup Screen 
The Analog Input Setup screen allows for the setting of the Analog Input signal sampling 
characteristics.  The list of available setup options in each drop-down menu is determined by 
using the same physical lists that are used by the hardware device drivers, eliminating the 
possibility of options being available in the list that are not actually applicable to the hardware. 
 

  
 

Field Purpose 
Bits Per Sample Sets the sample size as bits per sample. 
Voltage Range Sets the input voltage range. 
Impedance Sets the impedance for the selected Source. 
Coupling Sets the coupling method for the incoming signal. 
 
It is possible for the user to attempt to setup incompatible configurations.  For example, it may 
be that due to certain current limitations within the hardware it is not possible to select both a 
+/-10.0 VDC voltage range and 50 ohms impedance.  The evaluation is not performed until the 
user attempts to leave the window.  At that point a red exclamation mark will be displayed in the 
field that needs to be adjusted.  Hover over the mark with the cursor to view notes on what must 
be changed. 
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Analog Packet Format Setup Screen 
The Analog Packet Format Setup screen allows for setting the details of how the sampled Analog 
data will be packaged into chapter 10 packets.  As with other settings, the contents of each drop-
down menu are determined by the same physical lists that are used by the hardware device 
drivers.  As newer revisions of hardware add new capabilities, the menus will automatically 
reflect any new options available in a particular drop-down list.  If an incompatible selection is 
made a red exclamation mark will indicate where to make changes to eliminate the conflict. 
 

 
 
 

Field  Purpose 
Data Packing Mode Sets the Data Packing Mode.  The default mode is Packed. 
Data Format Sets the Data Sampling Format.  The default format is Offset Binary. 
Transfer Order Sets the Data Transfer Order.  The default is MSB First. 
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Analog Advanced Input Setup Screen 
The Analog Advanced Input Setup screen allows for making adjustments to the Chapter 10 
counter time stamps for the channel.  These adjustments can be made to accommodate known 
data link transport delays and allow for more accurate recording of time correlated data. 
 
It is possible to make this manual adjustment by checking the box on the left and entering a 
number in microseconds.  In the screen shot below, this would mean that the data on this 
channel would receive a Chapter 10 counter stamp that is 5 microseconds less than data 
simultaneously received on another channel that did not have this adjustment made. 
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Analog Output Setup 
 
The Analog Output Setup screen allows for setting Analog Output related parameters.   
 
By default, the Recorder will always play back the data at the recorded rate as specified in the 
TMATS header packet in the Chapter 10 file or an associated TMATS file. 
 
 

 
 

Field Purpose 
Voltage Range Sets the Output Voltage Range.  The default value is As Recorded.  In 

this mode, the data will playback across the same voltage range that 
was used when it was recorded.  1 volt in will be 1 volt out. 
 
If the Voltage Range is set to anything else, the output voltage will be 
scaled accordingly.  For example, consider the case where the input 
range was originally +/- 2V and the output range is set to +/- 5V.  In 
this case, if the input voltage was +1V, the output voltage will be 
+2.5V 

 
Just as with Analog Input Setup, it is possible to make an additional manual adjustment by 
checking the box in the Advanced Playback Offsets group and entering a number in 
microseconds.  In the screen shot above, this would mean that the data on this channel would be 
played back 2 microseconds later than data being played back on another channel that was 
similarly time stamped but did not have this adjustment made.  This is useful in accounting for 
known data transport delays that were not properly accounted for during the record process. 
 
Although the IMUX G2 Recorder does not record using analog subchannels, it is able to play 
back the first subchannel in analog packets that use the following subchannel structure: 
 

• Only one Channel Specific Data Word is used for all subchannels 
 

• Data is packed with 16 bits per word. 
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Analog Audio Channel Configuration 
The Chapter 10 specification does not specifically call out an Audio channel.  However the 
IMUX G2 includes the ability to record audio data and play it back within 300-millisecond 
accuracy using a standard audio card.  This data is stored in the Chapter 10 data file as Analog 
data.  For high- end MPEG encoding of audio channels, an audio/video input card must be used. 
 
 

Audio Setup Screen 
There is only one audio channel per IMUX G2 Recorder.  It will record from the source(s) defined 
by the System Recording Controls.  Recording two channels of audio can be accomplished by 
using the stereo line inputs.  The sample quality is always 16-bit stereo and only the sample rate 
is selectable. 
 

 
 
Select OK to commit the changes and close the window. 
 
Select Cancel to discard the changes to this channel and close the window. 
 
The Audio Setup screen also has <<Prev and Next>> buttons to allow quick maneuvering to 
the setup screens for the other channels in the system.  If any changes have been made to the 
channel setup, when selecting either of these buttons it is the same as hitting the OK button, 
committing any changes, and opening the setup window for another channel. 
 
Select Advanced to open the Audio Advanced Setup window. 
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Audio Advanced Setup Screen 
 

 
 
Just as with the PCM Input Setup screen, it is possible to make an additional manual adjustment 
by checking the box on the right and entering a number in microseconds.  In the screen shot 
above, this would mean that the data on this channel would receive a Chapter 10 counter stamp 
that is 1200 ticks greater than data simultaneously received on another channel that did not have 
this adjustment made. 
 
A similar screen is available for making timing adjustments during playback. 
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PCM Channel Configuration 
 
The main PCM Setup window allows for setting the expected rate of the input channel and the 
signal routing options. 
 
It also allows the user to bring 
up sub-windows used to set 
up the Bit Sync, the PCM 
Input, and the PCM Output. 
 
Use this screen to change the 
data rate and to select 
whether the PCM will receive 
its input directly from the Bit 
Sync or from an external 
source. 
 
Select the Bit Sync button to 
open the Bit Sync Setup 
window. 
 
Select the PCM Input button 
to open the PCM Input Setup 
window. 
 
Select the PCM Output 
button to open the PCM Output 
Setup window. 
 
Select the Internal radio button to have the PCM Input obtain clock and data directly from the 
integrated Bit Sync.  Whenever Internal is selected, the Bit Sync button will be available. 
 
Select the External radio button to have the PCM Input obtain clock and data from an outside 
source. When External is selected, the Bit Sync may or may not be available.  To make the Bit 
Sync available, ensure that the Output box is checked. 
 
If the Output box is checked, the Bit Sync will generate Clock and Data and will make it 
available on the rear panel connector.  If the Output box is not checked, the Clock and Data will 
not be available at the rear panel connector. 
 
Select OK to commit the changes and close the window. 
 
Select Cancel to discard the changes to this channel and close the window. 
 
The PCM Channel Setup screens also has <<Prev and Next>> buttons to allow quick 
maneuvering to the setup screens for the other channels in the system.  If any changes have 
been made to the channel setup, when selecting either of these buttons, it is the same as hitting 
the OK button, committing any changes, and opening the setup window for another channel. 
 
 
 



IMUX G2 – CHAPTER 10 REC0RDER  USER GUIDE 2.8p2 

54 
 

Bit Sync Setup Screen 
The Bit Sync Setup screen allows for the setting of all Bit Sync related parameters.  The list of 
available setup options in each drop-down menu is determined by using the same physical lists 
that are used by the hardware device drivers, eliminating the possibility of options being available 
in the list that are not actually applicable to the hardware. 
 

 
 

Field Purpose 
Deviation (%) Sets the maximum amount of absolute deviation from the target rate 

that a signal can have and still be considered in lock. 
Source If a Bit Sync has multiple input options, this list will include all of the 

available input sources. 
Impedance Sets the impedance for the selected Source. 
Input Code Sets the input code of the signal; used for selecting the algorithm that 

determines what signals will be counted as 1’s (ones) and what will be 
counted as 0’s (zeros). 
 

 
 

Input Polarity Sets whether an input “1” will be counted as a “1” or a “0.” 
Loop Bandwidth (%) Sets how much a bit time can change from one bit to the next and still 

be tracked.  A wider loop bandwidth may be necessary to capture a very 
jittery signal, but the result is a very jittery PCM clock and data stream. 

Bit Sync Lag (bits) This is a parameter that is reported by the hardware and placed here for 
reference.  Every Bit Synchronizer has a lag time between when a signal 
comes into it and when the signal goes out.  This time is measured in 
number of bits and the actual time lag is a function of the data rate.  
Knowing this number is helpful in determining true time data correlation. 

Output Clock Phase Sets the relationship of the output clock to the output data. 
Output Code Sets the PCM output code for the Bit Synchronized data. 
 

Note:    Unlike the PCM Input Setup, if the Bit Sync Input Code is set 
to one of the Randomized NRZ-L codes, the data will be de-
randomized and passed along as NRZ-L data. 
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PCM Input Setup Screen 
The PCM Input Setup screen allows for setting the PCM input related parameters associated with 
receiving data from an external PCM source.  If the Source is Bit Sync, these settings are 
irrelevant and are grayed out.  As with the Bit Sync settings, the contents of each drop-down 
menu are determined by the same physical lists that are used by the hardware device drivers.  As 
newer revisions of hardware add new capabilities, the menus will automatically reflect any new 
options available in a particular drop-down list. 
 

 
 
 

Field Purpose 
Data Mode The default mode is the PCM Throughput mode as described in the 

Chapter 10 Specification.  Other available selections are Packed and 
Unpacked.  Regardless of the mode selected, the Framing button is 
always enabled to allow access to the additional framing setup 
information. 

Source If a PCM Input has multiple input options, this list will include all of the 
available input sources. 

Impedance Sets the impedance for the selected Source. 
Input Code Sets the PCM Input Code format for the data being recorded. 

 

 
 

Clock Phase Sets the expected relationship of the input clock to the input data 
Data Polarity The Data Mode selected will have an effect on how this setting is 

applied.  When operating in Throughput Mode the field is informational 
only and is used to indicate whether the bits stored should be inverted 
prior to any further processing.  “Normal” indicates they do not need to 
be inverted.  “Inverted” indicates that the do need to be inverted prior to 

Note:    In Throughput mode, if the PCM Input Code is set to one of 
the Randomized NRZ-L codes, the data will not be de-
randomized, unless the “derandomize data” check box is 
checked.  Each bit will be stored as the same value it was 
received.  Viewing the packet with a packet viewer will show 
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Field Purpose 
any decommutation. 
 
When operating in Packed or Unpacked mode, the field is used to setup 
how the hardware will process the bits prior to searching for frame 
synchronization.  “Normal” indicates that the bits will be processed as 
they are received.  “Inverted” indicates the hardware is to invert the 
incoming bits prior to processing.  “Auto” indicates that the hardware is 
to attempt to establish synchronization both ways.  When set to Auto, 
any data that is inverted will be stored normally.  For some examples, 
consider when the synchronization pattern is set to EB90: 
 

1) If Data Polarity is set to Normal and the incoming pattern is 
EB90, EB90 is stored in the packet. 
 

2) If Data Polarity is set to Normal and the incoming pattern is 
146F, no synchronization is found and no packets are created. 
 

3) If Data Polarity is set to Inverted and the incoming pattern is 
EB90, no synchronization is found and no packets are created. 
 

4) If Data Polarity is set to Inverted and the incoming pattern is 
146F, EB90 is stored in the packet. 
 

5) If Data Polarity is set to Auto and the incoming pattern is EB90, 
EB90 is stored in the packet. 
 

6) If Data Polarity is set to Auto and the incoming pattern is 146F, 
EB90 is stored in the packet. 

 
De-Randomize 
before Recording 
 

Only enabled for +RNRZ-15 setting with version BM or higher.  If 
checked the input signal to the PCM Input module will de-randomized 
the signal before being recorded.  Otherwise, the incoming signal is 
recorded as is. 

 



IMUX G2 – CHAPTER 10 REC0RDER  USER GUIDE 2.8p2 

57 
 

PCM Frame Format Screen 
The PCM Frame Format Setup screen allows for setting the frame format details for the selected 
PCM stream.  These values will be used as the default values for the PCM Snapshot viewer.  In 
Throughput mode, all fields are optional.  In Packed mode, the Common Word Length, Words 
per Minor, Sync Pattern Length, and Sync Pattern fields must be provided.  Only valid entries will 
be updated and saved.  The PCM Subframe Synchronization Setup Screen can be accessed by 
selecting the Subframe Synchronization Details button. 
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Field Purpose 
Format Type Type of PCM Format.  The drop down list is limited to those specified by 

the TMATS P-d/TF attribute.  Packed mode data is stored MSB oriented 
and 32 bit aligned. 

PCM Format Section 
Common Word 
Length 

Specifies the number of bits for the default PCM data word size. 

Word Transfer 
Order 

Specifies the default for the first bit transferred in normal time sequence. 
In Packed mode, only MSB formatted data is supported 

Parity Specifies the normal word parity. 
Parity Transfer 
Order 

Specifies the location of the parity bit relative to the data word. 

Minor Frame Section 
Minors per Major Specifies the number of Minor Frames in the Major Frame. 
Words per Minor Specifies the number of words in a Minor Frame.  The Minor Frame 

synchronization pattern is always considered to be one word regardless 
of its length.  

Bits per Minor Calculated value defined as the number of bits in a minor frame including 
the minor frame synchronization pattern. 

Sync Type Specifies the Minor Frame Synchronization Type 
Synchronization Pattern Section 

Sync Pattern Length Specifies the minor frame synchronization pattern length in number of 
bits. 

Sync Pattern (Hex) Specifies the minor frame synchronization pattern using a hexadecimal 
format.  Assumes that the left most bit is the first bit transmitted.  Upon 
exit from this field, the binary Sync Pattern is automatically updated. 

Sync Pattern 
(Binary) 

Specifies the minor frame synchronization pattern using a binary bit 
pattern.  Assumes that the left most bit is the first bit transmitted.  Upon 
exit from this field, the hexadecimal Sync Pattern is automatically 
updated. 

Sync Mask (Hex) Specifies the minor frame synchronization bit mask using a hexadecimal 
format.  The most significant bit of the mask corresponds to the most 
significant bit of the sync pattern.  Upon exit from this field, the binary 
Sync Mask is automatically updated.  When operating in packed mode, 
this mask controls the primary frame synchronization compare engine.  A 
‘1’ bit within the mask will cause the corresponding Sync Pattern bit to 
be compared to the incoming data.  A ‘0’ bit within the mask will cause 
the corresponding Sync Pattern bit to not be compared to the incoming 
data.   

Sync Mask (Binary) Specifies the minor frame synchronization bit mask using a binary 
format.  The most significant bit of the mask corresponds to the most 
significant bit of the sync pattern.  Upon exit from this field, the 
hexadecimal Sync Mask is automatically updated.  When operating in 
packed mode, this mask controls the primary frame synchronization 
compare engine.  A ‘1’ bit within the mask will cause the corresponding 
Sync Pattern bit to be compared to the incoming data.  A ‘0’ bit within 
the mask will cause the corresponding Sync Pattern bit to not be 
compared to the incoming data.   
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Field Purpose 
Synchronization Criteria Section 

Max Bit Slip Specifies the number of bits the frame synchronization word is permitted 
to slip left (negative, ahead) or right (positive, behind) from the 
expected location of the frame synchronization word and still be counted 
as a valid instance. 

Matches For Lock Specifies the number of times in a row a valid synchronization pattern 
must be found in the expected location in order to move from Search to 
Lock.  Specifying a value of “0” indicates that Lock is established when 
the first instance of the synchronization pattern is found. 

Bit Errors For Lock Specifies the maximum number of bits in the synchronization pattern 
that can be in error and the pattern still be counted as valid.  Only 
applies when moving from Search to Lock. 

Misses to Drop Specifies the number of times in a row an invalid synchronization pattern 
must be found in the expected location in order to move from Lock to 
Search.  Specifying a value of “1” indicates that Lock is dropped when 
the first instance of an invalid synchronization pattern is found. 

Bit Errors to Drop This field specifies the maximum number of bits in the synchronization 
pattern that can be in error and the pattern still be counted as valid.  
Only applies when moving from Lock to Search.  Value must be “1” or 
greater.   

Subframe Synchronization Section 
Number of 
Subframe ID 
Counters 

Specifies the Number of Subframe ID Counters that are defined within 
the minor frame.  Only allowable values are 0 and 1. 

 

PCM Subframe Synchronization Format Screen 
The PCM Subframe Synchronization Format screen allows for setting the Subframe ID counter 
details.  There are two views available for this screen.  A limited view allows the user to see only 
the fields that require user data entry.  The more verbose screen displays all of the calculated 
and hard coded values that are based on the user data.  Use the Less and More buttons to 
switch between views. 
 
When attempting to save the entries via the [OK] button, any invalid value will be flagged.  The 
user will be prompted to save any valid fields.  Only valid entries will be updated and saved.  
Invalid values will not be output to a TMATS file nor to the Computer Generated Format 1 
(TMATS header) packet of the recorded file. 
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Field Purpose 
Counter Name Specifies the Subframe ID Counter Name.  Hard coded to “SFID”. 
Sync Type Defines the Subframe Synchronization Type.  Hard Coded to ID Counter 

“ID”. 
Counter Location Specifies the Minor Frame word position for the ID Counter.  The value 

must be greater than 1 (one) and less than the specified number of 
words in a Minor Frame. 

Counter Word 
Length 

Specifies, as a number of bits, the word length for the word containing 
the ID Counter.  Automatically set to match the Common Word Length. 

MSB Start Bit 
Location 

Specifies the bit location within the Counter Word that serves as the 
Most Significant Bit for the counter. 

Counter Length Specifies, as a number of bits, the subframe ID Counter Length.  The 
value is calculated based on the number of Minor Frames per Major and 
the ID Counter Initial Value. 

Transfer Order Specifies whether the most or least significant bit is transferred first.  
Automatically set to the same value as the Word Transfer Order. In 
Packed mode, only MSB formatted data is supported. 

Initial Value Specifies the expected Initial Value of the ID Counter. 
Initial Count 
Subframe 

Specifies the minor frame number associated with the initial count value.  
Automatically set to match the Initial Value. 

Counter End Value  Specifies the end value of the ID Counter.  Automatically calculated 
based on the Initial Value, Number of Minors per Major, and the Count 
Direction. 

End Count Subframe Specifies the minor frame number associated with the end count value.  
Automatically set to match the Counter End Value. 

Count Direction Specifies the direction of the ID Counter, either increasing or decreasing. 
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PCM Advanced Input Setup Screen 
The PCM Advanced Input Setup screen allows for making adjustments to the Chapter 10 counter 
time stamps for the channel.  These adjustments can be made to accommodate known data link 
transport delays and allow for more accurate recording of time correlated data. 
 
When recording multiple PCM streams that are operating at different rates through Bit 
Synchronizers, each stream will experience different Bit Sync data processing lag times.  This Bit 
Sync lag is expressed in bit times and can be found on the Bit Sync Setup screen. 
 
On the left-hand side of the Record Time Offsets group, is a check box that enables the user to 
choose whether or not to automatically account for the Bit Sync lag when time stamping the data 
from that particular PCM stream.  Checking the box will automatically adjust the counter by “X” 
microseconds where 
 

X = Bit Sync Lag (in bits) x 1,000,000 / Bit Rate. 
 

 
 
It is also possible to make an additional manual adjustment by checking the box on the right and 
entering a number in microseconds.  In the screen shot above, this would mean that the data on 
this channel would receive a Chapter 10 counter stamp that is 50 ticks less than data 
simultaneously received on another channel that did not have this adjustment made. 
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 PCM Output Setup 
 
The PCM Output Setup screen allows for setting PCM Output related parameters.   
 
By default, the Recorder will always play back the data at the recorded rate as specified in the 
TMATS header packet in the Chapter 10 file or an associated TMATS file.  It is also possible to 
specify alternate playback rates from this screen.  

 
 

Field Purpose 
Use Recorded Rate If selected, the output rate will be set to match the rate at which the 

data was recorded, including on-the-fly changes to data rate. If 
deselected, output data rate is user defined and TMATS setup change 
packets will be ignored. 
 

 
 

Rate Sets the PCM Output rate. If Use Recorded Rate is deselected, the rate 
can programmed by the user to the correct rate.  This is useful when the 
TMATS setup records do not have the correct rate specified. 

Rate Units Sets the units for the PCM Output rate value 
PCM Code Sets the PCM Output code to use for data reconstruction.  Generally this 

would be set to As Recorded.  However, there are times when a user 
may want to play back data using a different PCM code due to limitations 
on the equipment that will be receiving the data. 

 
Just as with PCM Input Setup, it is also possible to make an additional manual adjustment by 
checking the box on the right and entering a number in microseconds.  In the screen shot above, 
this would mean that the data on this channel would be played back 7 microseconds before data 
being played back on another channel that was similarly time stamped but did not have this 
adjustment made.  This is useful in accounting for Bit sync lag or other known data transport 
delays that were not properly accounted for during the record process. 
 
Although the IMUX G2 Recorder uses PCM throughput mode during recording to ensure that  
every bit is captured, regardless of frame lock status, it is able to play back packed and unpacked 
mode data packets that use either of the following structures: 
 

• Packed mode data in MSB First format 
 

Note:    Playing back data at a rate other than the actual recorded 
data rate may cause unexpected results. 
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• Unpacked mode data in MSB First format 
 
Note that PCM snapshot viewers work only with throughput mode data. 
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UART Channel Configuration 

UART Setup Screen 
The UART Setup screen allows for setting the parameters associated with receiving data from an 
external UART source. 
 

 
 
 

Field  Purpose 
Baud Rate Sets the baud rate for the channel.  Choose from the drop-down list.  

 

 
 

Parity Sets the parity for the channel.  Choose from the drop-down list. 
Data Bits Sets the data bits for the channel.  Choose from the drop-down list. 
Stop Bits Sets the stop bits for the channel.  Choose from the drop-down list. 
 
 
Select OK to commit the changes and close the window. 
 
Select Cancel to discard the changes to this channel and close the window. 
 
The UART Setup screen also has <<Prev and Next>> buttons to allow quick maneuvering to 
the setup screens for the other channels in the system.  If any changes have been made to the 
channel setup, when selecting either of these buttons it is the same as hitting the OK button, 
committing any changes, and opening the setup window for another channel. 
 
Select Advanced to open the UART Advanced Setup window. 

Note:   The UART setup information in the hardware configuration 
file includes a field to signify whether the hardware is 
installed to support either higher speed or lower speed 
signals.  This setting is used to determine the available baud 
rates. 
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UART Advanced Setup Screen 

 
 
 
Just as with the PCM Input Setup screen, it is possible to make an additional manual adjustment 
by checking the box on the right and entering a number in microseconds.  In the screen shot 
above, this would mean that the data on this channel would receive a Chapter 10 counter stamp 
that is 1000 ticks earlier than data simultaneously received on another channel that did not have 
this adjustment made. 
 
A similar screen is available for making timing adjustments during playback. 
 



IMUX G2 – CHAPTER 10 REC0RDER  USER GUIDE 2.8p2 

66 
 

Video Channel Configuration 

Video Setup Screen 
The Video Setup screen allows for setting the parameters associated with receiving and playing 
back data from an external video source. 
 

 
 
This Video Setup screen varies from other setup screens in that it allows making both input and 
output selections from the same screen. 
 
The Video Input Setup group allows the user to select a Video Encoding Algorithm from a list 
of available installed algorithms and to open another window that will display the format details 
for the selected algorithm.  The encoding algorithms have names that can be deciphered.  In the 
selection above, the encoding is MPEG 2, Transport Stream, NTSC, 3 Mbps constant bit rate. 
 
The Video output Setup group allows the user to select whether to reproduce the recorded 
video in the same format in which it is recorded, or specifically to play it as NTSC or PAL 
composite. 
 
Select Format Details to review the video packet format details. 
 
Select OK to commit the changes and close the window. 
 
Select Cancel to discard the changes to this channel and close the window. 
 
The Video Setup screen also has <<Prev and Next>> buttons to allow quick maneuvering to 
the setup screens for the other channels in the system.  If any changes have been made to the 
channel setup, when selecting either of these buttons it is the same as hitting the OK button, 
committing any changes, and opening the setup window for another channel. 
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Video Format Details Screen 
The Video Format Details screen displays the details for the video packets. 
 

  
 
The group labeled Video Format Details displays the details for the selected video encoding 
algorithm. 
 

Field Purpose 
Video Encoding Displays both the selected encoding scheme and the resolution. 
MPEG Packet Type Displays whether Packet Stream or Transport Stream has been selected. 
Video Source Displays whether NTSC or PAL has been selected. 
Video Bit Rate Displays what Video Bit Rate has been selected. 
Video Bit Rate Mode Displays whether the Video Bit Rate is Constant or Variable. 
 
The group labeled Packet Details allows the setting of details associated with the format of the 
Chapter 10 data packet. 
 

Field Purpose 
Packet Format Allows Selection of Format 0, 1, or 2.  This value may be restricted based 

on the encoding algorithm selected.  Choose from the drop-down list. 
Video Encoding Delay This field specifies the known video encoding delay in milliseconds.  Type 

in the value as a decimal integer. 
 
The group labeled Audio Details allows the setting of details associated with the capture of 
audio for inclusion in the video packet. 
 

Field Purpose 
Audio Sample Rate Allows selection of the audio sample rate. This value may be restricted 

based on the encoding algorithm selected.  Choose from the drop-down 
list. 

Audio Format Allows selection of the audio encoding algorithm. This value may be 
restricted based on the encoding algorithm and packet format selected.  
Choose from the drop-down list. 

 
Select Advanced to open the Video Advanced Setup window. 
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Video Advanced Setup Screen 

 
 
Just as with the PCM Input Setup screen, it is possible to make an additional manual adjustment 
by checking the box on the right and entering a number in microseconds.  In the screen shot 
above, this would mean that the data on this channel would receive a Chapter 10 counter stamp 
that is 1000 ticks earlier than data simultaneously received on another channel that did not have 
this adjustment made. 
 
A similar screen is available for making timing adjustments during playback. 
 
 

Ethernet Channel Configuration 

Ethernet Setup Screen 
There is no Ethernet Channel Setup screen required at this time.  Ethernet channels record all 
network traffic. 
 

 
 
  

Note:   Because the Ethernet connections are the same for both inputs and outputs the 
system does not provide a monitor feature during record even when Data Loop Through 
Enabled is selected. 
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1553 Channel Configuration 

1553 Setup Screen 
The 1553 Setup screen allows for setting the parameters associated with receiving data from an 
external 1553 source. 
 

  
 
 

Field  Purpose 
Test Item Description Enter the text description for the channel 
 
 
Select OK to commit the changes and close the window. 
 
Select Cancel to discard the changes to this channel and close the window. 
 
The 1553 Setup screen also has <<Prev and Next>> buttons to allow quick maneuvering to 
the setup screens for the other channels in the system.  If any changes have been made to the 
channel setup, when selecting either of these buttons it is the same as hitting the OK button, 
committing any changes, and opening the setup window for another channel. 
 
Select Advanced to open the 1553 Advanced Input Setup window. 
 

 
 

Note:   Because the 1553 connections are the same for both inputs and outputs the system 
does not provide a monitor feature during record even when Data Loop Through Enabled is 
selected. 
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1553 Advanced Setup Screen 
 

 
 
It is possible to make an additional manual adjustment by checking the box on the right and 
entering a number in microseconds.  In the screen shot above, this would mean that the data on 
this channel would receive a Chapter 10 counter stamp that is 1200 ticks greater than data 
simultaneously received on another channel that did not have this adjustment made. 

1553 Output Channel Setup Screen 
When accessing the setup screen from the Playback tab, the setup screen has one variation.  The 
center button is changed from Advanced to Output.  Select Output to view the advanced 
Output options. 
 

 
 
This screen allows the user to make an adjustment in the playback timing. 
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 429 Channel Configuration 

429 Setup Screen 
The 429 Setup screen allows for setting the parameters associated with receiving data from an 
external 429 source. 
 

 
 

 
 

Field  Purpose 
Test Item Description Enter the text description for the channel 
Subchannel The Subchannel / Bus is hard coded to “1” for all record sessions. 
Parity Select either Odd or None to indicate polarity of the 429 bus 
Bus Speed Select either Low or High to indicate speed of 429 bus to be recorded 
 
 
Select OK to commit the changes and close the window. 
 
Select Cancel to discard the changes to this channel and close the window. 
 
The 429 Setup screen also has <<Prev and Next>> buttons to allow quick maneuvering to the 
setup screens for the other channels in the system.  If any changes have been made to the 
channel setup, when selecting either of these buttons it is the same as hitting the OK button, 
committing any changes, and opening the setup window for another channel. 
 
Select Advanced to open the 429 Advanced Input Setup window. 
 

 

Note:   Because the 429 connections are the same for both inputs and outputs the system 
does not provide a monitor feature during record even when Data Loop Through Enabled is 
selected. 
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 429 Advanced Input Setup Screen 

 
 
It is possible to make an additional manual adjustment by checking the box on the right and 
entering a number in microseconds.  In the screen shot above, this would mean that the data on 
this channel would receive a Chapter 10 counter stamp that is 100 ticks greater than data 
simultaneously received on another channel that did not have this adjustment made. 

429 Output Channel Setup Screen 
When accessing the setup screen from the Playback tab the Subchannel field is activated.  If 
there is more than one subchannel defined, the field will be selectable and any one of the 
multiple subchannels may be selected for playback.  If the TMATS information for the data file 
does not specify any subchannel information, all data from all active subchannels will be played.   
Also, the center button is changed from Advanced to Output.  Select Output to view the 
advanced Output options. 
 

 
 

 
This screen allows the user to make an adjustment in the playback timing. 
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Best Data Engine (BDE) PCM Channel Configuration 
 
IMUX G2 has the ability to operate with an integrated Best Data Engine (BDE).  When this 
feature is enabled and properly configured, multiple PCM data streams will be merged into one 
Best Data Stream and provided to any targets enabled to receive data from that channel.   The 
output format of the BDE channel follows all of the rules for a standard PCM channel.  Once the 
data is recorded it can be mapped and played back just like any other PCM channel. 

BDE PCM Setup Screen 
The BDE PCM Setup screen is broken up into five major groups: Input Channels, Best Data 
Channel, Real Time Output, Frame Sync, and Frame Details. 
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The Input Channels group displays available PCM channels that are configured in Throughput 
mode and allows for selecting which PCM streams will be included as best data source (BDS) 
inputs to the BDE.  When the initial channel selection is made, only channels that have the same 
data rate can be selected for inclusion in the BDE processing. 
 



IMUX G2 – CHAPTER 10 REC0RDER  USER GUIDE 2.8p2 

75 
 

 
 

Note:   It is valid for there to be multiple R-groups in a TMATS header.  It is also valid for the 
same channel number, also known as track ID, to appear in each group.  It is not valid for the 
same channel number to appear more than once in a single R-group.  The BDE setup screen 
will display a channel number only once, regardless of how many times it appears in the 
TMATS header.    The order of precedence for determining which channels to present in the 
BDE PCM Setup Screen is listed below. 
 

1. The R-group with the ID attribute set to “TDS” is given priority. 
2. Subsequent R-groups are read in index order (i.e., R-2 is read before R-3). 
3. Within each R-group, the channel definitions are read in index order (i.e., R-2\TK1-1 is 

read before R-2\TK1-2).  If a duplicate channel number is ever encountered, the first 
instance is retained and any remaining instances are ignored. 

 
Example: 
Assume the following TMATS snippet where several attributes are presented in a somewhat 
random order: 

R-2\ID:RGroup 2 
R-2\TK1-1:1 
R-2\TK1-2:2 
R-2\TK1-4:3 
R-2\TK1-3:3 
R-3\ID:TDS 
R-3\TK1-1:1 
R-1\ID:RGroup 1 
R-1\TK1-1:2 

 
The Result: 

1. R-3 is given first priority because the R-3\ID:x attribute is set to TDS.  Therefore, 
Channel 1 will use the definition from R-3. 

2. Of the two remaining R-groups, R-1 and R-2, R-1 is given next priority because it is 
the lower index number.  Therefore, Channel 2 will be defined in R-1. 

3. Within R-2, Channel 3 is defined twice, in R-2\TK1-4:x and R-2\TK1-3:x.  R-2\TK1-3 is 
given priority because it is the lower index number.  Therefore, Channel 3 will be 
defined by TK1-3 in R-2. 
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The Best Data Channel group allows for setting the BDE channel number and the options that 
define how and which BDE algorithm will be applied. 
 

Field Purpose 
Channel Allows for setting the Chapter 10 channel number of the output BDE 

PCM stream. 
Max. Wait Time In order for the BDE to work, it needs to collect data from multiple 

similar sources.  The Chapter 10 standard allows data packets to be held 
off and merged into the Chapter 10 file up to one second after packets 
from another stream have been recorded to the file.  When processing 
previously recorded files, a stand alone BDE application would need to 
wait the entire one second before processing current data. 
 
In real-time applications this allowable delay may not be acceptable, and 
it might not even be occurring.  This field allows for a shorter maximum 
wait time to be specified.  If matching data is not available in time, the 
best decision will be made without it. 
 
The value is entered as a decimal integer that specifies the maximum 
number of milliseconds the algorithm will wait for “matching data” before 
it makes a best data selection. 

Algorithm Allows for the selection of the preferred BDE processing algorithm.  The 
drop-down list is currently limited to two, but in the future, it will be 
automatically updated whenever additional BDE processing algorithms 
are installed on the system. 
 
BitVote – Aligns data and performs a simple bit-by-bit count.  For each 
bit location, the bit value occurring the most often will be selected.  Only 
use this algorithm with three or more sources.  Using it with just two 
sources usually makes the data look worse. 
  
InLock-Weighted – Aligns data and makes decision based on which 
streams have been in lock the most, for the longest period of time, most 
recently.  It is a fairly complicated algorithm; the details of which are 
outside the scope of this manual. 

 
 
The Realtime Output group allows for selecting which available PCM output channel will be 
used for real time output of the resultant BDE stream.  The channel must be disabled and it must 
not be selected as a BDE input channel.  If there is no desire to create a physical output stream 
while in Monitor or Record modes, set this value to “None”.  Regardless of this setting, the Best 
Data Engine will create BDE packets for inclusion in the recording. 
 

Field Purpose 
Channel Number Allows for selecting an unused channel for real time play back in Monitor 

and Record modes.  Selecting “None” will release any previously 
reserved channel. 
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The Frame Sync group allows for setting the Frame Sync parameters for the minor frames of 
data in the PCM stream.  The entire frame sync is counted as one word. 
 

Field Purpose 
Pattern Allows for setting the Frame Sync Pattern.  The value is entered in 

hexadecimal. 
Mask Allows for setting the Frame Sync Mask.  The value is entered in 

hexadecimal. 
Size Allows for setting the Frame Sync Size.  The value is entered in decimal. 
 
 
The Frame Details group allows for setting the Frame Details for the minor frames of data in 
the PCM stream. 
 

Field Purpose 
Word Size Allows for setting the size the PCM Word Size.  The value is entered in 

decimal. 
Orientation Allows for selecting the PCM Word Orientation.  Choose from the drop-

down list. 
Total # of Words Allows for setting the # of PCM Data Words in the minor frame.  This 

value includes the Frame Sync word.  The value is entered in decimal. 
 
Select OK to commit the changes and close the window. 
 
Select Cancel to discard the changes to this channel and close the window. 
 
The BDE PCM Setup screen also has <<Prev and Next>> buttons to allow quick 
maneuvering to the setup screens for the other channels in the system.  When selecting either of 
these buttons, it is the same as hitting the OK button, committing any changes, and opening the 
setup window for another channel. 
 
The following screen shows that PCM channel 14 has been selected as a real time output for the 
BDE virtual stream.  It is the result of applying the settings displayed in the previously shown 
BDE PCM Setup screen.  The channel is shown as disabled, with the word “Virtual” in order to 
indicate it can not be used as an input.  Because it has been “hijacked” for use with a virtual 
stream, the channel will not loop through any data connected to the input and it can not be 
enabled for recording. 
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Status Log 

 
 
The Status Log maintains a log of selected types of events and error conditions that occur in 
the system.  It is possible to change the selected types that will be reported from the System 
Integrity Monitor Setup page. 
 
In addition to providing a log of events and errors the Status Log keeps track of the file paths 
and file names that have been used.  When recording starts an entry will be made to specify the 
path and partial file name being used to record the current target data.  When recording is 
completed an entry will be made to specify the complete path and final name of the recorded 
file.  When a file is opened for playback an entry will be made to specify the complete path and 
name of the opened file. 
 
Separate entries will be made for each channel as it is enabled or disabled either for record or for 
assignment to an individual target.  The data rate for the recorder and targets will be updated if 
the recorder is in monitor or record mode. 
 

 
 
All data that appears in the Status Log can also be stored to disk in a long-term log file.  This log 
file is stored in the G2 program directory and is named “G2LogFile”  When the file gets too big, it 
will automatically be renamed “G2LogFile.old” and a new “G2LogFile” file will be created.  When 
this file gets too big, it will overwrite the “G2LogFile.old” file without warning. 
 
The Status Log display will be cleared each time the application is closed and reopened.  This will 
not affect the data stored in the “G2LogFile”  file.  
 
To clear the Status Log display, right click in the Log File window and select Clear.  This will not 
affect the data stored in the “G2LogFile”  file. 
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Menu Details 

File 
 

• New

 

 will clear all current record and playback activity and return to the same state as if 
the application were just started. 

• Open TMATS Setup 

 

will open a TMATS file that will be used to configure the record 
channels. 

• Save TMATS Setup

 

 will save a TMATS file that contains the current configuration of the 
record channels.  If a TMATS file was opened, this will overwrite the previous TMATS file.  
If not, it will operate the same as Save As…. 

• Save as Default TMATS Setup

 

 will save a TMATS file with the current configuration of the 
record channels.  This file will be used to configure the record channels when the 
application is started and when New is selected. 

• Save TMATS Setup As  

 

will save a new TMATS file that contains the current configuration 
of the record channels. 

• Open Chapter 10 Data File

 

 will open a prerecorded data set and display the data on the 
Playback tab of the Channel Grid.  When selected, the Channel Grid, if open, will make 
the Playback tab the active data grid. 

• Open Raw Devices will populate a list of Tape Devices and Disk devices (on a USB or 
1394 Firewire interface) which can possibly contain a DTF file structure.  Once a device is 
selected a list of the files located on the device can be selected.  The selected file is then 
opened for playback. For example:  
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• Save File As 
 

will save the current Chapter 10 data set under a different name. 

• Open Channel Map

 

 will open a Channel Map file that assigns particular channel numbers 
from the current selected playback file to the current available hardware channels. 

• Save Channel Map
 

 will save a Channel Map file for future recall. 

• Exit
 

 will exit the application. 
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Setup 
 

 
 
The Setup menu allows for setting the configuration of the system as whole.  The only way to 
access the items on this menu is through the menus or the associated Hot Keys. 
 

Audio Feedback Enabled 
The IMUX G2 GUI includes an audible click that is played every time a button or icon is selected.  
It was included to provide additional positive feedback to the user when using a touch screen 
device. 
 
This menu item allows the user to turn this audible click on and off. 
 
When enabled, a checkmark will be displayed to the left of the text. 
 
It is also possible to change the audible click by placing a *.wav file in the same directory as the 
executable and naming the file “G2_Sound.wav.” 
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Record Nags Enabled 
This menu item allows the user to enable and disable the Record Nags. 
 
When this feature is enabled, the IMUX G2 will query the user for confirmation every time an 
action is taken that will affect the current recording of data.  For example, the message box 
shown below will be displayed if a user attempts to stop the recording while in Record mode. 
 

 
 
There are many different messages that might be displayed based on what a user is trying to 
change.  As another example, the following message will be shown if a user attempts to disable a 
channel while in Record mode. 
 

 
 
When Record Nags are enabled, a checkmark will be displayed to the left of the text. 

Media 90% Full Alarm 
The IMUX G2 GUI includes an alarm that is played when a media becomes 90% full during 
record/monitor operations. 
 
This menu item allows the user to enable and disable this media alarm. 
 
When enabled, a checkmark will be displayed to the left of the text.  Enabling the alarm will 
cause a default notifying alarm to sound when a media becomes 90% full during record/monitor 
operations.  The alarm will automatically turn off when the media is no longer 90% full.  Note 
that if disk space is made available while the alarm is sounding, it may take the system up to one 
minute to detect the newly freed space.  Because High Speed media only utilize pre-allocated 
disk space, newly freed space is not available to extend any active High Speed record sessions.  
 
It is also possible to change the alarm sound that is played when a media becomes 90% full by 
placing a *.wav file in the same directory as the executable and naming the file 
“G2_Alarm_Sound.wav.” 
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Data Loop Thru Enabled 
This menu item allows the user to enable and disable the Data Loop Thru feature. 
 
The IMUX G2 can play back data as it is being recorded.  These data are not sent to the media 
prior to being reconstructed.  The data are captured by the record channel, converted to a 
parallel digital format, transferred to the corresponding playback channel, and reconstructed.   
 
Because this feature works even when in Monitor mode, having data play out in Loop Through is 
not a guarantee that the data has made it to a Chapter 10 file.  When Data Loop Thru is enabled, 
it is not possible to play back other data sets at the same time a new data set is being recorded. 
 
When Data Loop Thru is enabled, a checkmark will be displayed to the left of the text. 
 
This is a global setting and applies to all channels. 

Log Files Enabled 
This menu item allows the user to enable and disable both the TOC file and the Playback and 
Recording Event Logging features. 
 
It affects both the status logging file referenced elsewhere in the manual and the creation of a 
table of contents (TOC file) that is used to track set-up changes that occurred during the 
recording of the data file (see the FAQs). 
 
When Log Files are enabled, a checkmark will be displayed to the left of the text. 
 

TMATS Setup Output Enabled  
This menu item allows the user to enable or disable the output of the TMATS Setup record for 
the Ethernet (UDP) target. The output rate when enabled will be once per second. 
 
When selected, a checkmark will be displayed to the left of the text. 
 
Making changes here will affect the Ethernet target output in all G2 modes (Monitor, Record, and 
Playback). 
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Set Classification 

  
 
This menu item allows the user to set the classification level for the next data file to be recorded. 
 
When selected, a checkmark will be displayed to the left of the text. 
 
Making changes here will change what will be displayed on the Classification bar. 
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Media Bandwidth Setup Menu 

 
 
Selecting Media Bandwidth… will open the Media Bandwidth Setup window.  This window is 
used to make Media and Bandwidth setting selections. 
 
It is possible to select up to 2 media for recording.  Use the drop-down menu to select the drive 
letter of the desired media.  To be able to select “None” from the drop down list, all targets 
assigned to the media must be disabled. 
 
The High Speed recording option allows the IMUX G2 to directly manage the disk I/O to the 
selected media.  If this option is selected, when recording starts, 98% of the remaining space on 
the media will be reserved for data recording.  In order to use high speed media, the user must 
have the permission SE_MANAGE_VOLUME_NAME.  In addition, for media to be selected as High 
Speed, the media must not be the system drive.  Any other drive that the Operating System 
considers to be a Removable Drive, Fixed Drive, or RAM Disk is eligible for high speed 
designation.  Network drives are not eligible for high speed recording.  Furthermore, only one 
target may point to a high speed media.  If a media has more than one target pointing to it, the 
request to make it high speed will fail. 
 
Selecting a media as High Speed will have an effect on the space remaining information that is 
displayed in the Status Tray.  High speed media are labeled with a prefix of “HS_” in the status 
bar.  The space remaining for high speed media is the percentage of the disk space that has 
been pre-allocated for high speed recording minus the bytes already recorded to disk.  This 
allows the user to see how much space is remaining for any particular record session.  Note that 
because High Speed media only utilize pre-allocated disk space, newly freed space is not 
available to extend any active High Speed record sessions. 
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A future option for IMUX G2 will be the ability to automatically analyze the maximum sustainable 
transfer rate to the selected media and across the PCI bus.  At that time the Analyze Media X, 
Analyze Ethernet, and Analyze PCI buttons will be enabled. 
 
In the status tray at the bottom of the IMUX G2 GUI application is a tri-color meter that monitors 
how much of the allocated Media or PCI Bandwidth is currently being utilized.  The fields titled 
100% Scale are used to determine what rate will be considered 100% usage of allocated rate.  
For each media and the PIC bus, select a transfer rate that will be used as the 100% scale. 
 
For example: If 1200 Mbps is entered in as the 100% scale for Media 1 and if the aggregate data 
transfer rate to and from Media 1 is 600 Mbps, the meter will show 50% utilization. 
 
Select OK to keep all changes and close the window.  Select Cancel to discard all changes, 
return to the original settings and close the window. 
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Target Setup Window 
 

 
 
 
After the Media have been defined, it is possible to select directories on the media as targets for 
recording.  This can be done by selecting Targets… from the Setup menu. 
 
For each Target, use the drop-down options to select from the media locations assigned in the 
previous step.  It is acceptable to have both Targets point to the same Media. 
 
For each Media Target, type in a path for recording or browse to a preexisting path. 

 
• It is possible to have both targets be different directories on the same media. 
 
• To record to the root directory of the selected media, enter “\” 
 
• Leaving the Target path blank will result in the target being disabled. 

The image below shows a typical directory structure as viewed from the Target Browse button. 
 
In this example, the user set a Target Directory of \IMUX_G2\Target_1\Structure.  For each 
record session, a new subdirectory will be created in the target directory. 
 
The subdirectory structure is: ch10dir_ddmmyyyy_xxx where 

dd is two digit day of month 
mm is two digit month of year 
yyyy is four digit year 
xxx is a sequential counter of recordings made in the directory. 
 

The date information is taken from the current system time. 
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For the Ethernet (UDP) Target, use the drop-down options to select the Network Interface Card 
(NIC).  The NIC is displayed as “Network name (IP Address) – Description”. If the NIC is not 
connected, its IP address will be displayed as “Unavailable”.  The setup values will be used for 
both RECORD/MONITOR and PLAYBACK Ethernet targets. 
 

• The Broadcast IP Address field is read-only and will be automatically filled in with a valid 
Broadcast address based upon the selected NIC Unicast address.  If this automatically 
derived address is not what is desired, it can be edited.  Specifying a Multicast/Unicast IP 
address will also work. 
 

• The destination port number defaults to 21435 and is the client’s port number to read 
the UDP packets from G2.  This field can be edited to meet the UDP client’s 
requirements. 
 

• Leaving the Target NIC blank will disable the target. 
 
 
Select OK to keep all changes and close the window. 
 
Select Cancel to discard all changes, return to the original settings, and close the window. 
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Time Setup Window 

 
 
Selecting Time… from the Setup menu will bring up the Time Setup window 
 
IRIG Time Input Options 
It is possible to select the IRIG Time Input Code for the system.  Available selections are IRIG 
B, IRIG A, and IRIG G standard time codes. 
 
Future versions of IMUX G2 will allow selecting recording at rates other than 1X. 
 
10 MHz Reference 
It is possible to slave the Chapter 10 Recorder 10 MHz counters to an external 10 MHz source.  
To do this, choose External as the 10 MHz Reference Source Selection.  Select Internal to use 
the onboard 10 MHz digitally tuned oscillator as a reference. 
 
Seed Select 
It is possible to seed the IRIG Time start value of the IMUX G2 with the current System Time.  
Once the time channel is started it will freewheel until it is reset by some activity in the GUI or 
until it is able to lock on to an external time source. 
 
It is also possible seed the IRIG Time start value with 001-00:00:00.00. 
 
Note that the IRIG Time channel is re-seeded whenever it is reset.  The channel is reset 
immediately after every record, every playback, and every time a user closes the Time Setup 
menu by using the OK button.  This allows the channel to start looking for and possibly obtain 
lock on the signal being provided prior to a user starting a Record session.  Already being in lock 
with an external source when recording is started will reduce startup times and ensure both an 
accurate file name and an accurate first time packet in the recorded file. 
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IRIG Time Output Options 
Future versions of IMUX G2 will allow the selection of IRIG Time Output Code regardless of the 
recorded code.  At this time IRIG-200 A, B, and G time codes will always play out as recorded.  
Other time codes such as Real time, UTC time, and GPS time will play out as IRIG B. 
 
Future versions of IMUX G2 will allow playing back at rates other than 1X. 
 
Select OK to keep all changes and close the window.  Select Cancel to discard all changes, 
return to the original settings and close the window. 
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TMATS G Group Editor Window 

 
 
Selecting TMATS G Group Editor… from the Setup menu will bring up the TMATS G Group 
Editor window. 
 
The G Group parameters in this editor are associated with the General Information Group defined 
in the Telemetry Attributes Transfer Standard (TMATS) Chapter 9 of the IRIG 106 standard.  If 
the information is not included in the TMATS file used to configure the unit, then the fields will 
remain null.  When the Playback grid is being displayed, the details from the most recently 
loaded file will be shown.  In all other cases, the information shown indicates what will be 
included in the TMATS header of the next record session. 
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Field Purpose 
Program Name Name of Program.  This field is not currently editable.  It will either 

display “Wyle TDS IMUX G2” or the program name read in from the 
TMATs header of a Chapter 10 file. 
 
When the editor is being used to display information from a file loaded to 
the playback grid, this field will display the Program Name found in the 
TMAS header of the chapter 10 file. 
 
When the editor is being used to display information for a file about to 
be recorded it will show “Wyle TDS IMUX G2”.  Take careful note of the 
following considerations. 
 
If a TMATS file is used to load the unit, and it does not have a Program 
Name attribute identified, if the TMATS information is saved, it will save 
the Program Name as “Wyle TDS IMUX G2”. 
 
If a TMATS file is used to load the unit, and it does have a Program 
Name attribute identified, if the TMATS information is saved, it will save 
the original name, even though this window will display Program Name 
as “Wyle TDS IMUX G2”. 
 
In all cases, a file recorded on an IMUX G2 will always have the 
Program Name set to Wyle TDS IMUX G2. 

Test Item Test Item Description. 
Origination Date Date of origination of this mission configuration. 
Update Date Date of update to configuration. 
Test Number Test identification. 
# of POCs Number of points of contact.  This field is not editable.  It reflects the 

number of points of contact defined in the TMATS file, TMATS header of 
a Chapter 10 file or current modifications to POCx-1 in the G Group 
Editor GUI.  

Name G\POC1-1  name 
Agency G\POC2-1 agency 
Address G\POC3-1 address 
Telephone G\POC4-1 telephone number 
Comments Additional information 
 
If an attribute is not defined it will be displayed showing the text value “null”. 
 
The point of contact fields of the G Group Editor only display the information defined for G\POCx-
1.  There may be other points of contact defined in a TMATS file or TMATS header of a Chapter 
10 file, but the G Group Editor only allows definition, modification or deletion of G\POCx-1. 
 
However, the # of POCs field will correctly reflect the value defined for G\POC\N in the TMATS 
file or TMATS header of a Chapter 10 file.  If the user adds or deletes G\POCx-1 in the G Group 
Editor, this value will be updated when OK is selected.  The correct # of POCs will be displayed 
when the GUI is reopened. 
 
Select OK to keep all changes and close the window.  Select Cancel to discard all changes, 
return to the original settings and close the window. 
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Built In Test and System Integrity Monitor Setup Window 
 
 
 

 
 
The IMUX G2 can be set to track critical software elements, versions, and registry settings and 
will analyze the system to determine if any of these values have changed.  Maintaining system 
configuration assures that no illegal modifications have been made to the system that could 
impact proper performance of the Recorder. 
 
Select Auto Analyze at Every Login to reanalyze the system every time a user logs into the 
machine and starts the application. 
 
Select Auto Analyze at Set System Time to re-analyze the system at the same time every 
day. 
 
Select Automatically Set New Restore Point at Each Shut Down to set a new system every 
time a user logs into the machine and starts the application.  This will assist in returning to a 
known working state if for some reason the system software configuration is corrupted. 
 
It is also possible to validate the system integrity at any time by selecting the Validate System 
Integrity button. 
 

Note: This feature is optional. 
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On occasion it might be necessary to make changes because of a new software load or a change 
in the hardware configuration of the system.  When this happens, the system might fail the 
system integrity check.  In those instances it is advisable to reset the baseline to the current 
configuration to prevent future unnecessary warnings and to establish a new baseline to monitor.  
To do this, select the Reset Baseline to Current Configuration button.  When this button is 
selected, a modal window will pop up to query the user as to whether or not they want to 
continue.  
 

 
 
Select OK to keep all reset the system baseline.  Select Cancel to keep the current baseline and 
close the Reset window. 
 
It is also possible to set the level of system status log details that will be sent to the Status Log 
window of the IMUX G2 GUI. 
 
In the Status Logging section of the System Integrity Monitor Setup window, select Enable 
Verbose Logging to log every message that is being sent to the log file.  Otherwise, only critical 
items that affect Recorder performance or data integrity issues will be reported to the on-screen 
Status Log.  Regardless of this setting and what is sent to the on-screen Status Log, all messages 
will be logged to the status file. 
 
For additional details on the status log see the section titled Status Log. 
 
When done modifying settings within the System Integrity Monitor Setup window, select OK to 
keep all changes and close the window.  Select Cancel to discard all changes, return to the 
original settings, and close the window. 
 
 

Note:     Once the baseline is reset, hitting the cancel button will not 
undo those changes.  Hitting cancel will only undo the setting 
changes made to the check boxes in the window. 
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View  

  
 

• Recorder Control
 

 will toggle the display of the Recorder Control window. 

• Recorded Time
 

 will toggle the display of the Recorded Time window. 

• Channel Grid
 

 will toggle the display of the Channel Grid. 

• Status Log
 

 will toggle the display of the Status Log. 

• Classification
 

 will toggle the display of the Classification bar. 

 
When a view is enabled, a checkmark will be displayed to the left of the text. 
 
For a more detailed understanding of how to use the menu items, review the section titled View 
Toolbar. 
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Ruler 

 
 
Time Ruler Format will allow setting the Time Ruler in the Data Grid window of the Channel Grid 
to display either Recorded or Relative Time.  The screen shot above shows that Recorded Time 
has been selected. 
 

 
 

 
 
Zoom will allow setting the Time Ruler in the Data Grid window of the Channel Grid to be 
displayed in a resolution from as low as 1 second per major tick mark to as high as 10 days per 
major tick mark. 
 
The screen shot above shows that a Zoom level of 10 minutes between major tick marks has 
been selected. 
 
For a more detailed understanding of how to use these menu items, review the section titled 
Time Ruler. 
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GoTo allows the user to set the starting offset within a chapter 10 data set.  The offset values 
are only used during playback, from either the RECORD or PLAYBACK grids. 
 
When selected, a submenu will be displayed showing Offset or Record Index. 
 

• Offset

 

 – When selected, a window allowing a raw hexadecimal offset value to be entered 
will be shown.  When entered, the offset will be converted to a time offset on the time 
ruler and will represent the start of the first chapter 10 packet boundary found after this 
offset. 

• Record Index

 

 - When selected, a submenu will be displayed showing All, Event, Time, 
and Other. The All selection will display the Record Index GUI with all record indexes 
listed.  The Event selection will display the Record Index GUI with all Event record 
indexes listed, if any. The Time selection will display the Record Index GUI with all Time 
record indexes listed, if any. The Other selection will display the Record Index GUI with 
all record indexes listed other than Event or Time, if any. 

Making changes here will affect the starting offset within a playback sessions in RECORD and 
PLAYBACK modes. 
 
Note, the GoTo feature has no effect when a DTF on a tape device has been selected for 
playback. 
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Transport 
 

 
 
The Transport Controls are just another way to manage the Record and Playback functions of the 
Recorder.  When selected they will operate in a fashion similar to the Recorder Transport Control 
toolbar and the larger Recorder Transport Control buttons. 
 
When selected or viewed, the menu items will be updated and highlighted to stay in sync with 
the other Recorder Transport Control methods. 
 
For a more detailed understanding of how to use these menu items, review the section titled 
Recorder Transport Control Toolbar 
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Shuttle 

 
 

• Set Left Marker
 

 will set the left marker to the current Time Marker position. 

• Set Right Marker
 

 will set the right marker to the current Time Marker position. 

• Use Constraints

 

 will toggle between using and not using the constraints during playback.  
When enabled, a checkmark will be displayed to the left of the text. 

• Shuttle Playback Enabled

 

 will toggle between continuous replay of the selected data 
segment or not. When enabled, a checkmark will be displayed to the left of the text. 

For a more detailed understanding of how to use these menu items, review the section titled 
Playback Constraints (Shuttle) Toolbar. 
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Tools 

  
 
 

Auto Align Multiple Chapter 10 Files 
This optional feature allows a user to load multiple Chapter 10 Files and correlate them based on 
IRIG Time data despite the fact that they have different Chapter 10 counters as the basis for 
their time data correlation. 
 
The application will analyze the time packet at the beginning of each Chapter 10 data file and will 
calculate an offset to apply to the Chapter 10 - 10 MHz Time Counter Stamp of each packet in 
order to have identical times play back at the same time.  The same necessary adjustments are 
then made to the other data channels and all data is now aligned based on the initial IRIG Time 
packets. 
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Configure G2PBO Mapping 
When the optional G2PBO feature is installed, selecting Configure G2PBO Mapping allows for 
creating the link between a Chapter 10 channel defined on the IMUX G2 Recorder and a 
corresponding stream defined in the OMEGA-SERV project.  For Video channels, it allows creating 
a link between a Chapter 10 video channel defined on the IMUX G2 Recorder and a 
corresponding user defined parameter in the OMEGA-SERV project. 
 
All selected IMUX G2 Recorder channels will appear on the left under the column heading 
Channel #.  A corresponding Stream Name or User Defined Parameter Name from OMEGA-
SERV must be entered for the data to be properly processed. 
 
The channel type for each Chapter 10 channel will appear under the column heading Channel 
Type. 
 

 
 
 
Select OK to commit the changes and close the window. 
 
Select Cancel to discard the changes and close the window. 
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Note 1: When in Record/Monitor mode, data is transferred across the PBO 
connection from IMUX G2 to OMEGA immediately and there is no 
discernable delay between the information displayed in the G2 GUI and the 
information displayed in OMEGA.  When playing back data to both the 
IMUX G2 hardware and to OMEGA, there is a noticeable time offset of 
several seconds between what is displayed in OMEGA and what is being 
played out of the IMUX G2.  While the same data is sent to both locations 
at the same time, the hardware connection maintains a buffer of data in 
order to be able to ensure it can survive any interruptions in the flow of 
data caused by system or network events. 

 
Note 2: When OMEGA-SERV is being used with G2PBO, an indicator in the Status 

control of OMEGA Manager indicates the current status of the PBO 
connection.   This status will either be Disconnected (Red), Connected 
(Green), or Re-connected (yellow).  In addition, a log message 
accompanies each status change. 

 
 Re-connected is considered a warning state because in some projects a 

temporary loss of data could cause certain calculations to become 
unreliable.  One example is a derived parameter that uses historical 
information to calculate current values.  If the data connection is 
interrupted, it may be necessary to reload the OMEGA project in order to 
reset the calculation and restore it to a reliable state.  A better long term 
solution may be to reevaluate the parameter calculation and add methods 
to internally reset if data interruption causes a problem. 
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Add BDE Virtual Channel 
When the optional G2-BDE feature is installed, selecting Add BDE Virtual Channel will add a 
channel of type BDE to the Channel Grid.  Once a channel is added it can not be removed.  To 
return to an environment with no BDE channels defined, it is necessary to restart the controller 
software. 
 
The temporary addition of a BDE Virtual channel is not retained as part of the system 
configuration.  Every time the controller software is restarted, any previously added BDE Virtual 
channels will have been deleted and will not show up in the Channel Grid. 
 
The details for how to set up a particular BDE Virtual channel are maintained in TMATS records.  
Wherever possible, TMATS records that are normally associated with PCM channels are used.  
Any additional information on how to set up the BDE Virtual channel is stored in vendor records.  
This allows the channel to show up as a standard PCM channel to all other applications that do 
not recognize the BDE Virtual channel TMATS vendor records. 
 
If BDE Virtual channel details have been saved in a TMATS file, it is possible to use those details 
to set up the channel.  For this to happen, the BDE Virtual channel must first be added to the 
Channel Grid.  Then open the TMATS file to load the BDE Virtual Channel details. 
 
Virtual channels are recorded as standard PCM channels.  The packet format of the BDE channel 
will be the same format as the selected BDE input channels.  When a PCM channel created by the 
BDE is played back from a previously recorded file, it will appear as a PCM channel. 
 
Because there is no hardware associated with the channel, BDE Virtual channels cannot be 
played back to hardware from the Record grid.  However, if G2-PBO is also installed, BDE data 
can be played back to OMEGA from the Record grid.  
 
BDE Virtual channels will only operate during Record/Monitor mode.  A BDE Virtual channel can 
not be used to create a new virtual stream during playback.  To create a Best Data channel after 
recording is complete, use the stand-alone Best Data Engine program to process the file. 
 

Play in OMEGA-FILE  
Selecting Play in OMEGA-FILE will open the OMEGA-SERV software application and will allow 
the user to view and play back the previously recorded Chapter 10 data file as if at a real-time 
telemetry ground processing station.  This does require that the project be defined within 
OMEGA-SERV.  Review the OMEGA-SERV File Playback help files for additional details on how to 
play back Chapter 10 files using the OMEGA-SERV File Reader. 
 

Analyze in ODE 
Selecting Analyze in ODE will open the ODE Desktop software application and allow the user to 
analyze the data stored in the Chapter 10 data file.  This does require an applicable OSPROJ file 
and supposes that the data set has already been manually published within ODE Publisher or was 
automatically published by ODE during data collection.  Review the ODE help files for additional 
details on how this works.  It is possible to change whether this button will start the ODE 
Publisher or the ODE Desktop application.  To establish which one, place a shortcut to the ODE 
application in the directory C:\Chapter 10 File Analysis Tools and name the shortcut “Start ODE.” 
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If OMEGA-SERV or ODE are not installed, an information box will pop up advising the user of the 
need to install the appropriate software.  Contact Wyle Telemetry and Data Systems for more 
details on acquiring OMEGA products.  

View Chapter 10 File  
Selecting View Chapter 10 File opens a Chapter 10 file viewer of your choice.  To establish the 
viewer, place a shortcut to the Chapter 10 file viewer program in the directory C:\Chapter 10 File 
Analysis Tools and name the shortcut “Start Ch10 Packet Viewer.”  This will bring up the viewer 
and allow you to select the Chapter 10 file of interest. 
 

Open TMATS in Wordpad  
Selecting Open TMATS in Wordpad opens the current TMATS viewer using a simple Wordpad 
text editor.  If any changes are made to the file the user will be prompted as to whether or not 
the changes should be applied to the next recording session. 
 

Open TMATS in OTIS 
If the OTIS TMATS editor is installed on the system, selecting Open TMATS in OTIS will 
automatically save the current TMATS information to a temporary file, open the file using the 
OTIS TMATS editor, allow the user to choose to Save the modified temporary TMATS file, and 
automatically load the updated TMATS information when OTIS is closed. 
 
If the editor is closed and changes are detected, the following message box will be displayed. 
 

 
 

If the editor is closed and changes are not detected, the following message box will be displayed. 
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Start File Transfer Utility  
Selecting Start File Transfer Utility opens a Chapter 10 file transfer utility of your choice.  To 
establish the link to the utility, place a shortcut to the Chapter 10 file viewer program in the 
directory C:\Chapter 10 File Analysis Tools and name the shortcut “Start File Transfer Utility.”  
This will bring up the selected utility. 

Start Standalone BDE 
Selecting Start Standalone BDE starts the optional stand alone Best Data Engine application 
which can be used for BDE post processing of previously recorded Chapter 10 data files.  If this 
software is not installed this option will not be enabled. 
 

Calculate PCM Rate 
Selecting Calculate PCM Rate starts the auto-calculation of the bit rate for all enabled PCM 
channels that are configured for external input.  To initiate the calculation process, the system 
must be idle and the channel(s) must be in Throughput mode.  While the calculation is active, a 
modal dialog will appear indicating the progress of the calculation process.  This progress dialog 
contains a Cancel button which allows the user to cancel the calculation process.  When the 
calculation completes, the rate for each of the evaluated channels is updated to the computed 
rate and the dialog is updated to indicate the status of the calculation process. 
 
If the computed rate for an individual channel does not fall within the supported range, the 
individual channel will be disabled. 
 
To view the computed rates, activate the Setup dialog for each of the applicable channels.  This 
calculation process supports calculating bit rates within the range of 3 Kbps – 50 Mbps 
 

Export 
This optional feature allows a user to export selected segments of selected channels to a new 
Chapter 10 file. 
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Help 
 
 
 
Selecting Help Topics will load an electronic version of this 
manual. 
 
 

 
 
Selecting About IMUX G2 will pop up a modal 
window that provides details on installed 
software version numbers and contact 
information.  
 
The core software is listed at the top of the 
screen. 
 
Any extensions to IMUX G2 are listed in the 
extensions table. 
 



IMUX G2 – CHAPTER 10 REC0RDER  USER GUIDE 2.8p2 

107 
 

Remote Control of the IMUX G2 Recorder 
 
The IMUX G2 can be controlled remotely via a Serial Control Interface either directly through a 
serial port on the machine, or using a virtual serial port accessible via a Telnet session. 

Serial Control Setup 
To use the serial port application, browse to the installation directory, typically “C:\Program 
Files\Telemetry and Data Systems\G2”, and select the application “G2SerialController.exe”. 
 
The application is used to establish the communication connection and to monitor and display the 
command and response sequences.  It cannot be used to issue commands. 
 
Select the required communication port settings using the drop down menus located at the top of 
the window.  Select Start to allow communication. After Start has been selected the text will 
change to Stop.  To stop communications or change settings, select Stop.  To close the 
application select the white “x” in the red box in the upper right hand corner of the window. 
 

 
 
Default start-up options are stored in a serial configuration file as described in Appendix 6 – 
IMUX G2 Serial Controller Configuration Files. 
 

Telnet Control Setup 
Telnet control is accomplished by using the serial control application previously described as well 
as a Virtual Serial Port application that is included on the system.  The HW Virtual Serial Port 
2.5.10 Software is installed on IMUX G2 systems and configured with default values.  This 
application receives commands via TELNET and sends them to a virtual serial port on the same 
system.  The following steps describe how to configure with the default values. 
 
Start up the HW Virtual Serial port application by selecting the Windows Start -> All Programs 
-> HW Virtual Serial Port 2.5.10 -> HW Virtual Serial Port. 
 
Within the application, on the Settings tab, ensure the following items are checked and then 
select “Save Settings Now”: 
 

 HW VSP works as the TCP Server only 
 Create VSP Port when HW VSP startup 
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 Hide to Tray when HW VSP startup 
 Start HW VSP with Windows 

 
Within the application, on the Virtual Serial Port tab, set the IP address (default is 127.0.0.1) and 
the Port (default is 23).  Set the port Name to a valid unused com port name such as COM5.  
Select “Create COM”. 
 
If successful, the following message will be displayed in the application window: 

 
Sending test ping to 127.0.0.1 device 
Virtual serial port COM5 created 

 

Using Telnet for Remote Control 
Remote control of the IMUX G2 recorder cannot run concurrent with the IMUX G2 GUI.  If the 
GUI is running, exit the IMUX G2 GUI application. 
 

1. Start the IMUX G2 Controller application on the IMUX G2 system. 
2. Start the IMUX G2 Serial Controller application on the IMUX G2 system.  The application 

can be found in the IMUX G2 installation directory: C:\Program Files\Telemetry and Data 
Systems\G2\G2SerialController.exe. 

3. Determine the IP address of the G2 system. 
a. Select Windows Start -> Run and type in CMD 
b. At the command prompt, type in ipconfig 
c. Note the IP address ___________________________ 

4. On a remote system networked to the G2 system, set up the HyperTerminal 
a. Start HyperTerminal by selecting Windows Start-> All Programs-> 

Accessories->Communications->HyperTerminal 
b. HyperTerminal window will come up with a Connection Description Window in 

front of it.  Type in a name for the connection and select on OK. 
c. The “Connect To” window will come up. If the “Connect To” window does not 

automatically appear, click the drop list next to “Connect Using” and choose 
TCP/IP (Winsock).   In the “Connect using” field, select “TCP/IP (Winsock)“. 

d. Set the IP address to the IP address of the IMUX G2 noted in step 3c. 
e. Set port number to 23 and select OK. 
f. Within the application, select File -> Properties -> Settings -> ASCII setup 

and ensure the application is set to “Send line ends with line feeds” and to 
“Echo typed characters locally”.  Exit all setup dialog windows. 

5. Send Commands from the HyperTerminal via Ethernet, for example “.STATUS” 
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Appendix 1 – Frequently Asked Questions 
1. What happens to my current record or playback session if the GUI is shut down? 

In both Record and Playback mode, the session will continue.  However, when the GUI is 
reopened while the unit is in Record mode, all data segments will be gone and the 
display will start drawing new data segments based on the current channel configuration. 

 
2. How is the channel configuration determined when recording a data file? 

When opening the application for the first time, the software will automatically load the 
information in the Default TMATS file.  It is also possible to load a TMATS file from 
another location.  If that is done, then any settings that are included in that TMATS file 
will override the previous settings.  In addition, it is possible to make changes manually 
using the channel setup screens.  Any changes made in the channel setup screen will 
override the previous settings. 
 

3. How can I rename my channel? 
A channel can be renamed by changing it in the TMATS header file and loading the 
TMATS header. 
 

4. What is the default channel naming configuration? 
The default naming convention is “DataLink X” where X is the Channel Number. 

 
5. How do I change the default configuration file? 

Change the default configuration file by selecting File > Save As Default TMATS Setup. 
 
6. How is the channel configuration determined when playing back a data file? 

The channel configuration is determined first by the information in the TMATS packet 
that is in the Chapter 10 data file.  When loading a new data file, the software will also 
automatically look for a TMATS file with the same name located in the same directory.  
Any settings that are included in that file will override the previous settings.  In addition, 
it is possible to make changes manually using the channel setup screens.  Any changes 
made in the channel setup screen will override the previous settings. 
 

7. How can I see how a channel was setup in a previously recorded Chapter 10? 
Move to the Playback tab in the Data Grid.  Open the data file of interest.  Map the 
recorded channel of interest to a playback channel.  Click on the Channel Number in the 
Channel Details Section to open the PCM Setup window.  The information for the record 
settings for the channel will be displayed. 

 
8. If I have multiple data segments with different configurations on a single channel, how do I 

make sure I am looking at the configuration information for a particular segment? 
Place the Current Time Marker so it is over the Data Segment of interest.  All 
configuration information that is displayed will be for what was in effect at that Time 
location. 
 

9. How does the system keep track of configuration changes? 
Whenever a channel is disabled or enabled during a recording, a Computer Generated 
Format 2 Event is generated to mark the channel Configuration Change.  This is closely 
followed by a complete Computer Generated Format 1 Setup record with the Setup 
Record Configuration Change bit(8) set in the channel specific data.   The controller and 
playback use these packets to determine how to draw the displays and what 
configuration information to use.  To speed up file access the Computer Generated 
Format 3 packets containing Recording Indexes are used to locate the Event packets. 
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10. What is the Table of Contents (*.toc) file and why do I care about it? 

In earlier versions of IMUX G2 software, the Table of Contents file was a support file 
created when recording a Chapter 10 file on an IMUX G2 recorder.  Each file contained a 
summary of all disabling, enabling, and reconfiguring of data channels during a record 
session.  This file was stored in the same directory as the data file and had the same 
name but with the “.toc” extension.   During playback this file was used to create the 
Data Segments in the Data Grid portion of the Channel Grid display.  As of version 2.7 
these files are no longer used. 
 

11. What will the data grid show if I want to play back a Chapter 10 file recorded on someone 
else’s Chapter 10 Recorder? 

The question should really be “what would be displayed on the data grid if the file 
selected for playback is not a Chapter 10 file from an IMUX G2 recorder.  In this case, 
any recorded channel that is defined in the TMATS packet that is mapped to a playback 
channel will have a data segment that extends for the entire period regardless of 
whether or not the channel was enabled for the entire recording period. 

 
12. What is Monitor Mode and how do I use it? 

Monitor mode is a mode that is similar to Record except that no data is recorded to the 
Target locations.  It is helpful for ensuring there is signal activity on all input channels, 
that the IRIG source is connected and in lock, and that the hardware is passing data 
cleanly to the software.  If Data Loop Thru mode is enabled, Monitor mode allows data 
to be transferred to and reconstructed through the associated playback channels. 

 
13. How often does the GUI update? 

The GUI displays receive status updates from the hardware control software 
approximately 10 times per second.  Every item that changes is updated and redrawn as 
necessary. 

 
14. If an error occurs very quickly will it be viewable by the Status LEDs? 

In short, yes.  The Status LEDs are updated 10 times per second, but they are not 
sampled.  They are data driven and will light red if there was any error in the last 
100-millisecond reporting period.  If there was an error, the light will stay lit for at least 
one second. 
 
It is also possible to hover over a particular LED and see the error counts for the 
channel.  If Verbose Logging is enabled, any error that would cause a channel LED to 
light red will be reported in the Status Log and stored in the Status Log file. 

 
15. How do I slave the IMUX G2 counter to an external 10 MHz time source? 

Select Setup > Time to get to the Time Setup menu.  In the 10 MHz Reference Source 
Selection box, select External. 
 

16. How do I turn off the sound? 
Turn off the sound by hitting CTRL-A or by selecting File > Setup > Audio Feedback 
Enabled 

 
17. How do I change the default sound? 

Change the default sound by placing a *.wav file in the same directory as the executable 
and naming the file “G2_Sound.wav.” 
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18. When using a PCM channel’s bit sync input, why do I still get green lights on a channel even 
if no input is connected.? 

The green LED indicates that data is flowing from the hardware into the application for 
processing.  When the bit sync input is used it will try and find bits even when there are 
no bits to be found.  The AGC circuit will amplify the input and start to derive bits out of 
any level of noise it can find.  In the near future bit sync lock information will also be 
represented in the channel LEDS.  If the bit sync is not in lock, the red LED will light.  It 
is possible to have both the green and red LEDs lit at the same time. 
 

19. I changed the data rate for my channel, why is it not recording properly? 
We have found that even our testers will sometimes change the numbers for the data 
rate and forget to change the units.  Double check the channel’s setup screen and ensure 
that both the number and the units are properly set. 
 

20. How do I setup to record two separate missions to two separate targets if the two missions 
overlap but do not start or stop at the same time? 

There are several ways to do this but we’ll just describe one; we’ll also assume that each 
channel is already configured as required.  Using the Record Enable Buttons, enable only 
the channels that will be needed for the first mission.  Ensure that each channel for the 
mission is enabled in both the CHNL column and in the T1 column.  At this point only the 
channels required for the first mission should be yellow.  Using the Record Enable 
Buttons, now enable the channels that will be needed for the second mission.  Ensure 
that each channel for the mission is enabled in both the CHNL column and in the T2 
column.  Temporarily disable Target 2 by selecting the ‘T2’ column header.  All of the T2 
enable boxes should be faded to blue.  When recording starts, only T1 will start 
recording data.  When it is time to start the second simultaneous mission, enable Target 
2 by selecting the ‘T2’ column header.  Since the unit is already recording, immediately a 
new file will be opened and data for the second mission will be stored on Target 2.  To 
stop recording to either target while continuing to record to the other, select the 
appropriate ‘T1’ or ‘T2’ column header.  Each time a target is re-enabled a new data file 
will be started and stored in the same target directory as the previous data file.  
Selecting ‘STOP’ will stop all recording to all targets. 
 

21. The GUI screen sometimes freezes when using the snapshot viewer, will that affect my 
recorded data? 

No.  The record thread is isolated from the GUI and is not affected by GUI screen 
updates. 

 
22. What is Simulation mode and how do I use it? 

Simulation mode was designed to allow a user to interact with most every part of the 
GUI without requiring that any hardware be installed in the system.  The only screens 
that can not be viewed while in Simulation mode are the Snapshot viewers.  No data is 
recorded and no data can be played back.  To run in Simulation mode, first ensure the 
IMUX G2 Controller application is not running.  Then start the IMUX G2 Simulation and 
the standard IMUX G2 GUI application. 
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Appendix 2 – Definitions 
BIT
 

 – Built In Test. 

Channel Grid

 

 – the primary GUI window that provides access to all channel-specific record and 
playback configuration and data information. 

Current Time Marker – a yellow line with a red border that shows the current time of a playback 
or record session.  When idle, it shows the location from which the next playback would start. 
 
Data Segment – graphical segments displayed in the data grid that show channel status over 
time.  Each bar includes the start time and stop time as a graphic overlay.  A new data segment 
is started when a channel is enabled during the record process and is stopped when a channel is 
disabled during the record process.  
 
Data Grid – the right-most portion of the Channel Grid that allows viewing of the recorded data 
segments 
 
GUI – standard acronym for Graphical User Interface 
 
Idle Mode – when the unit when it is not in Record, Playback, or Monitor mode. 
 
Media – a physical device with a drive letter that is accessible to the IMUX G2 Recorder.  It can 
be a local or remote media as long as it has a drive letter associated with it. 
 
Monitor Mode – when the unit is collecting data and displaying activity but not storing the data to 
any Target. 
 
Playback Mode – when the unit is currently playing data back from a recorded Chapter 10 file. 
 
Record Mode – when the unit is recording data to predefined Targets on predefined media. 
 
Recorder Transport Control – buttons, icons and menu items that allow for controlling the mode 
of the  Recorder (Idle, Monitor, Record, and Playback) and the Current Time Marker position. 
 
Status Log – a GUI window that provides a viewable log of all status information. 
 
Status Tray – the bottom portion of the IMUX G2 main screen that shows current resource 
utilization information. 
 
Target – a directory on a media.  It is possible to have multiple Targets point to different or even 
the same directories on the same Media. 
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Appendix 3 – Icons, Accelerators, and Hot Keys 

File 
Title Icon Accelerator Hot Keys Task 

New 
 

Alt, F, N Ctrl + N 

Clear all current record and 
playback activity and return to 
same state as if the application 
were just started. 

Open TMATS Setup 
 

Alt, F, O Ctrl + O Open a TMATS file that will be used 
to configure the record channels. 

Save TMATS Setup  Alt, F, S Ctrl + S 

Save a TMATS file that contains the 
current configuration of the record 
channels.  If a TMATS file was 
opened, this will overwrite the 
previous TMATS file.  If not, it will 
operate the same as Save As…. 

Save as Default 
TMATS Setup 

 Alt, F, D Ctrl + D 

Save a TMATS file with the current 
configuration of the record 
channels.  This file will be used to 
configure the record channels when 
the application is started and when 
New is selected. 

Save TMATS Setup 
As 

 Alt, F, A  
Save a new TMATS file that 
contains the current configuration 
of the record channels. 

Open Chapter 10 
File  

  

Open a prerecorded data set and 
display the data on the Playback 
tab of the Channel Grid.  When 
selected, the Channel Grid, if open, 
will make the Playback tab the 
active data grid. 

Save File As    
Save the current data set under a 
different name. 

Open Channel Map 
 

  

Open a Channel Map file that 
assigns particular channel numbers 
from the currently selected 
playback file to the current 
available hardware channels. 

Save Channel Map    
Save a Channel Map file for future 
recall. 

Exit  Alt, F, X  Exit the application. 
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Setup 
Title Icon Accelerator Hot Keys Task 

Audio Feedback 
Enabled 

 Alt, S, A Ctrl + A Toggle the Audio Feedback feature 
on and off. 

Record Nags 
Enabled 

 Alt, S, N  Toggle the Record Nags feature on 
and off. 

Media 90% Full 
Alarm 

 Alt, S, M  Toggle the Media 90% Full Alarm 
feature on and off. 

Data Loop Thru 
Enabled 

 Alt, S, L Ctrl + L Toggle the Data Loop Thru feature 
on and off. 

Log File Enabled  Alt, S, O  Toggle the Log file and TOC 
features on and off. 

Set Classification  Alt, S, C  

Set the classification level for the 
next recorded session. 
K = Unknown 
U = Unclassified 
C = Confidential 
S = Secret 
T= Top Secret 
O = Other 

Media Bandwidth  Alt, S, B Ctrl + B Open the Media Bandwidth Setup 
page. 

Targets  Alt, S, G Ctrl + G Open that Recording Target Setup 
page. 

Time  Alt, S, T Ctrl + T Open the Time Setup Page. 

TMATS G Group 
Editor 

 Alt, S, E Ctrl + E Open the TMATS G Group Editor, 

BIT & System 
Integrity 

 Alt, S, I Ctrl + I Open the System Integrity monitor 
Setup page. 
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View  
Title Icon Accelerator Hot Keys Task 

Recorder Control 
 

Alt, V, R  
Toggle the display of the Recorder 
Control window. 

Recorded Time 
 

Alt, V, T  
Toggle the display of the Recorded 
Time window. 

Channel Grid 
 

Alt, V, G  
Toggle the display of the Channel 
Grid. 

Status Log 
 

Alt, V, L  
Toggle the display of the Status 
Log. 

Classification  Alt, V, C  
Toggle the display of the 
Classification bar. 

 

Ruler 
Title Icon Accelerator Hot Keys Task 

Time Ruler Format  Alt, R, T  
Select between displaying Recorded 
Time or Relative Time in the Time 
bar. 

Zoom  Alt, R, Z  

Select between displaying time in 
the Time bar in increments of 1 
second, 10 seconds, 1 minute, 10 
minutes, 1 hour, 10 hours, 1 day, 
or 10 days per major tick mark. 

 

 Transport 
Title Icon Accelerator Hot Keys Task 

Beginning of Data 
 

Alt, T, B  
Set the Time Marker to the 
beginning of data location. 

Rewind 
 

Alt, T, W  
Set the Time Marker to a position 
that is one major tick marks worth 
of time prior to the current position. 

Stop 
 

Alt, T, S Ctrl + Q Stop the current record or playback 
activity. 

Play 
 

Alt, T, P Ctrl + P Playback from the current position. 

Fast Forward 
 

Alt, T, F  
Set the Time Marker to a position 
that is one major tick mark’s worth 
of time after the current position. 
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Title Icon Accelerator Hot Keys Task 

End of Data 
 

Alt, T, E  
Set the Time Marker to the end of 
data location. 

Event 
 

Alt, T, V Ctrl + V 

Insert an event marker during 
record.  Event markers will be 
stored in the Chapter 10 data file as 
Event Marker packets in accordance 
with the Chapter 10 specification. 

Monitor Data 
 

Alt, T, R, M Ctrl + M 
Clear the display and start 
monitoring the data that is available 
for recording. 

Record Data 
 

Alt, T, R, R Ctrl + R Clear the display and start 
recording to a new Chapter 10 file. 

 

Shuttle 
Title Icon Accelerator Hot Keys Task 

Set Left Marker 
 

Alt, H, L Ctrl+Left Set the left marker to the current 
Time Marker position. 

Set Right Marker 
 

Alt, H, R Ctrl+Right Set the right marker to the current 
Time Marker position. 

Use Constraints 
 

Alt, H, U Ctrl + U Toggle between using or not using  
the constraints during playback. 

Shuttle Playback 
Enabled  

Alt, H, E Ctrl + E 
Toggle between continuous replay 
of the selected data segment or 
not. 
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Tools 
Title Icon Accelerator Hot Keys Task 

Auto Align Multiple 
Chapter 10 Files 

 Alt, O, A  

Future Feature: Allows the user to 
select multiple Chapter 10 input 
files for input, auto align their data 
segments based on recorded time, 
and play them back simultaneously. 

Configure G2PBO 
Mapping 

 Alt, O, G  
Optional Feature: Opens the 
Configure G2BO Channel Map 
window. 

Add BDE Virtual 
Channel 

 Alt, O, B  
Optional Feature: Adds a BDE 
Virtual Channel to the Channel Grid. 

Play in OMEGA File  Alt, O, F 
 

 

Opens OMEGA File and allows the 
user to play the data in the 
currently selected Chapter 10 file 
data segment 

Analyze in ODE  Alt, O, D 
 

 

Opens ODE and allows the user to 
publish and analyze the data in the 
currently selected Chapter 10 file 
data segment. 

View Chapter 10 
File 

 Alt, O, V 
 

 

Opens a user-selected Chapter 10 
Viewer to view the TMATS 
information for the current data 
segment. 

Open TMATS in 
Wordpad 

 Alt, O, W 
 

 

Opens a user-selected TMATS 
viewer to view the TMATS 
information for the current data 
segment. 

Open TMATS in 
OTIS 

 Alt, O, O  

Optional Feature: Opens the OTIS 
TMATS editor for viewing and 
editing the current IMUX G2 
TMATS configuration information. 

Start File Transfer 
Utility 

 Alt, O, U  
Opens a user selected Chapter 10 
File Transfer Utility. 

Calculate PCM Rate  Alt, O, C  

Starts the auto calculation of the bit 
rate for all enabled PCM channels 
that are configured for external 
input. 

Export  Alt, O, X  

Future Feature: Exports the 
selected data segment to a single 
stream Chapter 10 data file with 
Time data. 
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Help 
Title Icon Accelerator Hot Keys Task 

Help Topics  Alt, P, H F1 Opens the Help document. 

About IMUX G2  Alt, P, A  Opens the About window. 
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 Appendix 4 – IMUX G2 Hardware Configuration Files  
 
The IMUX G2 Hardware Configuration is stored in an XML file named “hconfig.xml..”   The file 
must be stored in the same directory in which the application is stored, under a subdirectory 
named “ConfigFiles..” 
 
This file is used to determine which I/O channels will be displayed on the Channel Grid and how 
those channels map to the physical hardware installed in the system. 
 
Each file must start out with the following header lines. 
 
<?xml version="1.0" standalone="yes"?> 
<hconfig xmlns="http://tempuri.org/hconfig.xsd"> 
  <hconfigInformation> 
    <Version>Version 1.3</Version> 
  </hconfigInformation> 
 
Each file must end with the following line. 
 
</hconfig> 
 
PCM I/O are defined as follows. 
 

XML Field Field Explanation 
<PCM4IN1Boards> Header required to indicate start 

of each PCM 4in1 board. 
<RotaryDialSetting>0</RotaryDialSetting> Current setting of the hardware 

rotary switch.  Only one board 
can be set to  ‘0’. 

<Comment>Factory Default Settings</Comment> Comment Field 
<ChannelType1>IRIG</ChannelType1> Channel Type for on-board IRIG 

channel.  Do not change this 
field. 

<HardwareChannelNumber1>5</HardwareChannelNumber1> Hardware Channel Number for 
on-board IRIG channel.  Do not 
change this field. 

<Ch10ChannelNumber1>100</Ch10ChannelNumber1> Chapter 10 Channel Number to 
be used for the on-board IRIG 
channel.  This field is user 
changeable.  If multiple 4-in-1 
boards are installed this value 
must be set to 0 for all boards 
except the Master. 

<StreamName1 /> Placeholder for Stream Name for 
the on-board IRIG channel.  It is 
currently not user changeable. 

<ChannelType2>PCM</ChannelType2> Channel Type for first PCM 
channel.  Do not change this 
field. 

<HardwareChannelNumber2>1</HardwareChannelNumber2> Hardware Channel Number for 
first PCM channel.  Do not 
change this field. 
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XML Field Field Explanation 
<Ch10ChannelNumber2>1</Ch10ChannelNumber2> Chapter 10 Channel Number to 

be used for the first PCM 
channel.  This field is user 
changeable. 

<StreamName2>Stream1</StreamName2> Stream Name for first PCM 
channel.  This field is user 
changeable. 

<ChannelType3>PCM</ChannelType3> Channel Type for second PCM 
channel.  Do not change this 
field. 

<HardwareChannelNumber3>2</HardwareChannelNumber3> Hardware Channel Number for 
second PCM channel.  Do not 
change this field. 

<Ch10ChannelNumber3>2</Ch10ChannelNumber3> Chapter 10 Channel Number to 
be used for the second PCM 
channel.  This field is user 
changeable. 

<StreamName3>Stream2</StreamName3> Stream Name for second PCM 
channel.  This field is user 
changeable. 

<ChannelType4>PCM</ChannelType4> Channel Type for third PCM 
channel.  Do not change this 
field. 

<HardwareChannelNumber4>3</HardwareChannelNumber4> Hardware Channel Number for 
third PCM channel.  Do not 
change this field. 

<Ch10ChannelNumber4>3</Ch10ChannelNumber4> Chapter 10 Channel Number to 
be used for the third PCM 
channel.  This field is user 
changeable. 

<StreamName4>Stream3</StreamName4> Stream Name for third PCM 
channel.  This field is user 
changeable. 

<ChannelType5>PCM</ChannelType5> Channel Type for fourth PCM 
channel.  Do not change this 
field. 

<HardwareChannelNumber5>4</HardwareChannelNumber5> Hardware Channel Number for 
fourth PCM channel.  Do not 
change this field. 

<Ch10ChannelNumber5>4</Ch10ChannelNumber5> Chapter 10 Channel Number to 
be used for the fourth PCM 
channel.  This field is user 
changeable. 

<StreamName5>Stream4</StreamName5> Stream Name for fourth PCM 
channel.  This field is user 
changeable. 

</PCM4IN1Boards> Trailer required to indicate end 
of each PCM 4in1 board. 
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Analog I/O Channels are defined as follows. 
 

XML Field Field Explanation 
</AnalogBoards> 
 

Header required to indicate start of 
each Analog interface 

<RotaryDialSetting>0</RotaryDialSetting> Current setting of the hardware rotary 
switch.  Only one board can be set to  
‘0’. 

<Comment>Factory Default Settings</Comment> Comment Field. 
<HardwareChannelNumber>1</HardwareChannelNumber> Must be set to as follows: 

  1: First Analog Channel on Board. 
  2: Second Analog Channel on Board. 
  3: Third Analog Channel on Board. 
  4: Fourth Analog Channel on Board. 
  5: IRIG Channel on Board. 

<Ch10ChannelNumber>21</Ch10ChannelNumber> Chapter 10 Channel Number to be used 
for the channel.  This field is user 
changeable.  If the board is not the 
master, set the channel number for the 
IRIG channel to ‘0’. 

<ChannelType>ANALOG</ChannelType> 
 

When the <HardwareChannelNumber> 
listed above is set from 1-4, set this 
field to ‘ANALOG’. 
 
When the <HardwareChannelNumber> 
listed above is set to 5, set this field to 
‘IRIG’. 

</AnalogBoards> Trailer required to indicate end of each 
Analog interface 

 
 
Audio I/O Channels are defined as follows. 
 

XML Field Field Explanation 
<AudioBoards> Header required to indicate start of 

each Audio Analog interface 
<RotaryDialSetting>0</RotaryDialSetting> Must be set to 0. 
<Comment>Factory Default Settings</Comment> Comment Field. 
<HardwareChannelNumber>0</HardwareChannelNumber> Must be set to 0. 
<Ch10ChannelNumber>201</Ch10ChannelNumber> Chapter 10 Channel Number to be 

used for the Audio Analog channel.  
This field is user changeable. 

</AudioBoards> Trailer required to indicate end of 
each Audio Analog interface 

 
 
 
 
 



IMUX G2 – CHAPTER 10 REC0RDER  USER GUIDE 2.8p2 

122 
 

UART I/O Channels are defined as follows. 
 

XML Field Field Explanation 
<UARTBoards> Header required to indicate start of 

each UART channel. 
<RotaryDialSetting>0</RotaryDialSetting>  Must be set to 0. 
<Comment>COM1</Comment>  Comment Field. 
<HardwareChannelNumber>1</HardwareChannelNumber>  Must be set to the COM# for the 

port as understood by the 
operating system.  For example to 
access COM_1, the  value must be 
set to 1 ; to access COM_2, the 
value must be set to 2. 

<Ch10ChannelNumber>401</Ch10ChannelNumber>  Chapter 10 Channel Number to be 
used for the UART channel.  This 
field is user changeable. 

</UARTBoards> Trailer required to indicate end of 
each UART channel. 

 
 
Video I/O Channels are defined as follows. 
 

XML Field Field Explanation 
<VideoBoards> Header required to indicate start of 

each Video channel. 
<RotaryDialSetting>0</RotaryDialSetting>  Must be set to 0. 
<Comment>Video 1</Comment>  Comment Field. 
<HardwareChannelNumber>1</HardwareChannelNumber>  Must be set to 1 for the first Video 

channel, 2 for the second Video 
channel, etc... 

<Ch10ChannelNumber>501</Ch10ChannelNumber>  Chapter 10 Channel Number to be 
used for the Video channel.  This 
field is user changeable. 

</VideoBoards> Trailer required to indicate end of 
each Video channel. 
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Ethernet I/O Channels are defined as follows. Note that an Ethernet port that is used for channel 
I/O can not be used for Ethernet Target output. 
 

XML Field Field Explanation 
<EnetBoards> Header required to indicate start of 

each Ethernet channel. 
<RotaryDialSetting>0</RotaryDialSetting>  Must be set to 0. 
<Comment>G2_Port_1</Comment>  Must be set to the “Friendly” name 

for the Ethernet Port.  The Friendly 
name refers to the user settable 
name used for the port by the 
Operating System.  This can be 
changed by going to Network 
Connections, right clicking on a 
port, and selecting the Rename 
option. 

<HardwareChannelNumber>1</HardwareChannelNumber>  Must be set to 1 for the first 
Ethernet channel, 2 for the second 
Ethernet channel, etc... 

<Ch10ChannelNumber>601</Ch10ChannelNumber>  Chapter 10 Channel Number to be 
used for the Ethernet channel.  
This field is user changeable. 

</EnetBoards> Trailer required to indicate end of 
each Ethernet channel. 

 
1553 I/O Channels are defined as follows. 
 

XML Field Field Explanation 
<MILSTD_1553Boards> Header required to indicate start of 

each 1553 channel. 
<RotaryDialSetting>0</RotaryDialSetting>  Must be set to 0. 
<Comment>Factory Default</Comment>  Comment Field 
<HardwareChannelNumber>1</HardwareChannelNumber>  Must be set to 1 for the first 1553 

channel, 2 for the second 1553 
channel, etc... 

<Ch10ChannelNumber>701</Ch10ChannelNumber>  Chapter 10 Channel Number to be 
used for the 1553 channel.  This 
field is user changeable. 

</MILSTD_1553Boards> Trailer required to indicate end of 
each 1553 channel. 
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429 I/O Channels are defined as follows. 
 

XML Field Field Explanation 
<A429Boards> Header required to indicate start of 

each A429 channel. 
<RotaryDialSetting>0</RotaryDialSetting>  Must be set to 0. 
<Comment>Factory Default</Comment>  Comment Field 
<HardwareChannelNumber>1</HardwareChannelNumber>  Must be set to 1 for the first A429 

channel, 2 for the second A429 
channel, etc... 

<Ch10ChannelNumber>801</Ch10ChannelNumber>  Chapter 10 Channel Number to be 
used for the A429 channel.  This 
field is user changeable. 

<ChannelType></ChannelType> Channel Type Indicator.  Field not 
currently used, but descriptors are 
required. 

</A429Boards> Trailer required to indicate end of 
each A429 channel. 
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Appendix 5 – IMUX G2 System Configuration Files  
 
The IMUX G2 System Configuration contains system level settings including path details for 
media and targets and is stored in an XML file named “SystemConfiguration.xml”.   The file must 
be stored in the same directory in which the application is stored, under a subdirectory named 
“ConfigFiles..” 
 
Each file must start out with the following header lines. 
 
<?xml version="1.0" standalone="yes"?> 
<SystemConfiguration xmlns="http://tempuri.org/SystemConfiguration.xsd"> 
 
Each file must end with the following line. 
 
</SystemConfiguration> 
 
 
Media details can be manipulated from within the GUI and are stored in this file.  The details are 
defined as follows. 
 

XML Field Field Explanation 
<Media> Header required to indicate start of each Media 

device. 
<Number>0</Number> Reference number for this media.  First media is 

“0,” second media is “1”. 
<DriveLetter>F:</DriveLetter> Drive letter of media device as understood by the 

operating system. 
<MaxThroughput>1200</MaxThroughput> Maximum Throughput field used to determine what 

throughput rate will indicate 100% on the Status 
Tray. 

<Media> Trailer required to indicate end of each Media 
device. 
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Target details can be manipulated from within the GUI and are stored in this file.  The details are 
defined as follows. 
 

XML Field Field Explanation 
<Targets> Header required to indicate start of each Target 

description. 
<Number>0</Number> Reference number for this target.  First target is “0,” 

second target is “1”, etc…. 
<MediaNumber>0</MediaNumber> For targets of Type “Disk”: 

Media Number associated with the Drive Letter on 
which this target will record data. 
 
For other target types this field must be set to “2”. 

<DirectoryPath>\G2</DirectoryPath> For targets of Type “Disk”: the Directory Path 
specifying in which directory on the media this target 
will record data. 
 
For targets of Type “OMEGA”, “Playback OMEGA”, and 
“SnapshotEthernet”:  the port number that the two 
applications will use to communicate.  Examples of 
port numbers to use are “1200” and “1201”.  This 
field should only be changed if the applications are 
not running.  
 
For targets of Type “Ethernet” and 
“PlaybackEthernet”: the structure is as follows 
[Target IP Address] [Target IP Port] [reserved] [Local 
NIC IP Address] 

    <Type>Disk</Type> Specifies the Type of Target.  Options include the 
following. 
   Disk 
   Ethernet 
   OMEGA 
   PlaybackEthernet   PlaybackOMEGA 
   SnapshotEthernet 

    <Enabled>True</Enabled> Specifies whether or not the target is enabled.  If a 
target is not enabled, no data can be sent to it. 

  </Targets> Trailer required to indicate end of each Target 
description. 
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System Parameter details can be manipulated from within the GUI and are stored in this file.  
The details are defined as follows. 
 

XML Field Field Explanation 
<SystemParameters> Header required to indicate start of System 

Parameters section. 
<PCIMaxBandwidth>500</PCIMaxBand
width> 

PCI Maximum Bandwidth field used to determine 
what throughput rate will indicate 100% on the 
Status Tray. 

<Clock10MHzReferenceSource>dInternal
</Clock10MHzReferenceSource> 

Specifies whether 10 MHz Reference clock is set to 
“Internal” or “External..” 
Field value should be set to “dInternal” for internal 
clock. 
Field value should be set to “dExternal” for external 
clock. 

</SystemParameters> Trailer required to indicate end of System 
Parameters section. 
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Appendix 6 – IMUX G2 Serial Controller Configuration 
Files  
 
The IMUX G2 Serial Controller Configuration contains serial port settings for remotely controlling 
the unit and is stored in an XML file named “SerialConfiguration.xml.”.   The file must be stored in 
the same directory in which the application is stored, under a subdirectory named “ConfigFiles..” 
 
Each file must start out with the following header lines. 
 
<?xml version="1.0" standalone="yes"?> 
<SerialConfiguration xmlns="http://tempuri.org/SerialConfiguration.xsd"> 
 
Each file must end with the following line. 
 
</SerialmConfiguration> 
 
 
Media details can be manipulated from within the GUI and are stored in this file.  The details are 
defined as follows. 
 

XML Field Field Explanation 
<SerialConfiguration> Header required to indicate start of serial 

configuration 
<PortName>COM5</PortName> Com port name 
<BaudRate>19200</BaudRate> Baud Rate: 9600, 19200, 38400, 57600, 115200, 

230400, 460800, 921600 
<DataBits>8</DataBits> Data bits: 5, 6, 7, 8 
<Parity>None</Parity> Parity:  Even, Odd, None, Mark, Space 
<StopBits>1</StopBits> Stop bits:  1, 1.5, 2 
<FlowControl>Hardware</FlowControl> Flow Control:  Xon/Xoff, Hardware, None 
</SerialConfiguration> Trailer required to indicate end of serial configuration 
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Appendix 7 – Mapping TMATS to IMUX G2 
 
The original release of IMUX G2 was built using the IRIG 106-05 Chapter 9 TMATS standard but 
borrowed some necessary elements from what was then the pending -07 standard.  It is 
currently up to date with the -09 standard.  The table below provides details on the currently 
used TMATS attributes and where they are accessed from the IMUX G2 environment. 
 
All TMATS attributes are now stored so that each attribute is followed by a CR/LF – allowing 
easier readability of the information. 
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TMATS 
Attribute (05/07) 

TMATS 
Description 

G2 Name / Hard Coded Value G2 Location Acceptable Values Default Values 

General for Entire Recording 
G\PN: Program (Project) 

Name Wyle TDS IMUX G2 Hard coded Any Wyle TDS IMUX G2 
G\TA: Test Item Test Item Setup->TMATS G 

Group Editor Any Any 
G\OD: Origination Date Origination Date Setup->TMATS G 

Group Editor Any Any 
G\UD: Update Date Update Date Setup->TMATS G 

Group Editor Any Any 
G\TN: Test Number Test Number Setup->TMATS G 

Group Editor Any Any 
G\POC\N: Number of Points 

Of Contacts # of POCs Setup->TMATS G 
Group Editor Any Any 

G\POC1-1: POC Name POC Name Setup->TMATS G 
Group Editor Any Any 

G\POC2-1: POC Agency POC Agency Setup->TMATS G 
Group Editor Any Any 

G\POC3-1: POC Address POC Address Setup->TMATS G 
Group Editor Any Any 

G\POC4-1: POC Telephone POC Telephone Setup->TMATS G 
Group Editor Any Any 

G\DSI\N: Number of Data 
Source(s) 1 Hard coded Any 1 

G\DSI-1: Data Source 
Identifier 

"IMUX G2" (older) or "TDS" 
(newer) Hard coded N/A “TDS” 

G\DST-1: Data Source Type 
(Storage) STO (older), REP (newer) Hard coded STO, REP REP 

G\106: IRIG-106 version 
(106-09) 5, 7 (older), 9 (newer) Hard coded 5, 7, 9 9 

G\SC: Security Level Security Level Setup-->Set 
Classification U, C, S, T, O U 
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TMATS 
Attribute (05/07) 

TMATS 
Description 

G2 Name / Hard Coded Value G2 Location Acceptable Values Default Values 

G\COM: 

Comments Comments Setup->TMATS G 
Group Editor 

Any 

"TMATS file created by 
Telemetry and Data 
Systems IMUX-G2" 

R-x\ID: Data Source 
Identifier 

"IMUX G2" (older) or "TDS" 
(newer) Hard coded Any 1 

R-x\N:  Number of Tracks 
or Channels Number of Channels Hconfig file N/A SELECTED MEDIA 

R-x\RID: Source Identifier SELECTED MEDIA Hard coded N/A 0 
R-x\NSB: Number of Source 

Bits 0 Hard coded N/A I 
R-x\RRML: Recorder-

Reproducer Media 
Location I for Internal Hard coded N/A I 

R-x\RI3 
Original Recording YES or NO 

Set based on how 
the file was 
created Y, N Y 

R-x\RI4 
Date and Time 
Created MM-DD-YYYY-HH-MI-SS 

Set based on 
current system 
time at start of 
recording. Any Today 

R-x\RI5 

Date of Copy MM-DD-YYYY-HH-MM-SS 

Set based on 
current system 
time when 
creating a file 
using stand alone 
BDE post 
processing. Any Today 

R-x\RI6: Post Process 
Modified Recording 

N for No Hard coded 
N/A N  

R-x\CRE: Continuous 
Recording Enabled 

F for False Hard coded 
N/A F  

R-x\RSS: Recorder- C for Command Setup File Only Hard coded N/A C 
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TMATS 
Attribute (05/07) 

TMATS 
Description 

G2 Name / Hard Coded Value G2 Location Acceptable Values Default Values 

Reproducer Setup 
Source 

R-x\EV\E: Recording Events 
Enabled 

T for True (newer) F for False 
(older) Hard coded N/A N  

R-x\EV\IEE: Recorder Internal 
Events Enabled 

T for True (newer) F for False 
(older) 

Hard coded 
T, F  N/A 

R-x\EV\N: Number of 
Recording Events 2 Hard coded Any 2 

R-x\EV\ID-1: Recording Event 
Identifier SETUP_REC_CONFIG_CHANGE Hard coded   

R-x\EV\D-1: Recording Event 
Description 

SETUP RECORD 
CONFIGURATION CHANGE Hard coded N/A  

R-x\EV\P-1: Recording Event 
Priority 3 for during recording Hard coded N/A 3 

R-x\EV\T-1: Recording Event 
Type R for Recorder Hard coded N/A R 

R-x\EV\LC-1: Recording Event 
Limit Count 65535 Hard coded N/A 65535 

R-x\EV\MS-1: Recording Event 
Measurement 
Source NONE Hard coded N/A NONE 

R-x\EV\MN-1: Recording Event 
Measurement Name NONE Hard coded N/A NONE 

R-x\IDX\E: Recording Indexes 
Enabled F for False Hard coded T, F  T 

R-x\IDX\IT: Recording Index 
Type T for Time Hard coded N/A T  

R-x\IDX\ITV: Recording Index 
Time Interval 10000000 for 10 seconds Hard coded N/A 10000000 

V-y\TDS\VER: TDS version of spec 1.0 Hard coded 1.0.0, 1.1.0, 1.2, 1.3 1.3 
V-y\ID: Data Source 

Identifier TDS Hard coded “IMUX G2”, “TDS” “TDS” 
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TMATS 
Attribute (05/07) 

TMATS 
Description 

G2 Name / Hard Coded Value G2 Location Acceptable Values Default Values 

V-y\VN: Vendor Name? TDS Hard coded “TDS” “TDS” 
V-y\TDS\G2N: Number of G2 

channels Number of Channels Hconfig file N/A 1 
Applies to ALL Channels 

R-x\TK1-n: Track 
Number/Channel Id Chapter 10 Channel Number Hconfig file Any N/A 

R-x\TK4-n: Channel ID To 
Recorder Physical 
Channel 

Channel Number 

Set to match 
Ch10 Channel 
Number found in 
Hconfig file. Any DataLink <chan> 

R-x\DSI-n: 

Data Source 
Identifier Channel Name 

Defaults to 
DataLink <chan> 
but is user 
editable on the 
channel grid Any N/A 

R-x\CDT-n: Channel Type Channel Type Hconfig file Any DataLink <chan> 
R-x\CHE-n: 

Channel Enabled   Channel Grid 
1553IN, 429IN, ANAIN, 
ETHIN, PCMIN,TIMEIN, 
UARTIN, VIDIN N/A 

R-x\CDLN-n: PCM data Source Id 
(Bus data source Id) Channel Name See R-1\DSI-n: T for Enabled, F for 

Disabled Disabled 
V-y\TDS\DLN-n: Data Link Name Channel Name See R-1\DSI-n: Any DataLink <chan> 
V-y\TDS\TYP-n: 

Channel Type Channel Type Hconfig file 
1553IN, 429IN, ANAIN, 
ETHIN, PCMIN,TIMEIN, 
UARTIN, VIDIN N/A 

V-y\TDS\CAO-n: Ch10 apply counter 
offset Ch10 Apply Counter Offset Advanced Input YES or NO NO 

V-y\TDS\CCO-n: Ch10 counter offset Ch10 Counter Offset Advanced Input Any 0 
V-y\TDS\TGT\N-
n: 

Number Enabled 
Targets Number of Targets System config file Any 0 

V-y\TDS\TE-n-m: Targets Target enabled Channel Grid T, F  Unknown 
V-y\TDS\LTE-n:  Loop Through 

Enabled Loop Through Enabled Setup menu T, F  F 
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TMATS 
Attribute (05/07) 

TMATS 
Description 

G2 Name / Hard Coded Value G2 Location Acceptable Values Default Values 

Time Channels 
R-x\TTF-n Data type format 1 for Format 1 (Time Data) Hard coded 1 1 
R-x\TFMT-n: Time Format TimeCode Time Setup GUI A, B,G, I B  
R-x\TSRC-n: Time Source E for External Hard coded I, E E for External 
V-y\TDS\TRA-n: Time Rate 1 Hard coded ¼, ½, 1, 2, 4 1 
V-y\TDS\TSE-n: Time Seed ZERO Hard coded SYSTEM, ZERO, PRESET ZERO 

Audio Channels 
R-x\ATF-n: Analog Type 

Format 1 Hard coded N/A 1 
R-x\ACH\N-n: Number of Analog 

channels 
per packet 

2 Hard coded 
N/A 2 

R-x\ADP-n: Analog Data 
Packing Option YES Hard coded N/A YES 

R-x\ASR-n: Analog Sample 
Rate Audio Rate (16, 44.1, 48 khz) Audio Setup GUI. 16000, 44100, 48000 16000 

R-x\AMN-n-m: Analog 
Measurement 
Name 

AUDIO<m> Hard coded 
N/A "AUDIO1" 

R-x\ADL-n-m: Analog Data Size 
(16 bits) 16 Hard coded 16, 8 16 

R-x\AMSK-n-m: Measurement Bit 
Mask FW  (full word) Hard coded N/A FW 

R-x\AMTO-n-m: Transfer Order 
(Default) D Hard coded N/A D 

R-x\ASF-n-m: Sample Factor 
(always 0) 0 Hard coded N/A 0 

R-x\AV-n-m: Audio Present Y  Hard coded N/A Y 
R-x\AVF-n-m: AUDIO FORMAT  WAV Hard coded WAV, RAW WAV 
V-y\TDS\ACS-n 
 
 
 

Audio Chan1 
Source 

LINEIN (Sound Card Line In - 2.0 
and lower) or DEFAULT (System 
Default - 2.1) 

Hard coded; 
viewable on Audio 
Setup GUI. LINEIN, MIC, OTHER, 

DEFAULT DEFAULT 
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TMATS 
Attribute (05/07) 

TMATS 
Description 

G2 Name / Hard Coded Value G2 Location Acceptable Values Default Values 

Analog Channels 
R-x\ATF-n: Analog Data Type 

Format 1 = Format 1 (Discrete Data) Hard coded 1 1 
R-x\ACH\N-n: Number of Analog 

Channels 
per Packet 

1 Hard coded 
Any 1 

R-x\ADP-n: Analog Data 
Packing Option AnalogDataMode Analog Setup GUI YES, NO YES 

R-x\ASR-n: Analog Sample 
Rate AnalogSampleRate Analog Setup GUI Any 1000000 

R-x\AMN-n-m: Analog 
Measurement 
Name 

ANA_CHxxxx Hconfig (xxxx = 
channel #) N/A ANA_CH<chan> 

R-x\ADL-n-m: Analog Data Length AnalogBitsPerSample Analog Setup GUI Any 8 
R-x\AMSK-n-m: Measurement Bit 

Mask   
Derived from 
Analog Setup GUI 
(Data Mode) Any FW 

R-x\AMTO-n-m: Transfer Order 
(Default) M – Most Significant Bit First 

Hard coded, 
viewable on 
Analog setup GUI. l, m M 

R-x\ASF-n-m: Sample Factor 
(always 0) 0 Hard coded N/A 0 

R-x\ASBW-n-m: Sample Filter 3DB 
Bandwidth in Hz AnalogFilter Analog Setup GUI 

0, 1000, 10000, 100000, 
1000000, 6000000, 
20000000 0 

R-x\ACP-n-m: Signal Coupling AnalogCoupling Analog Setup GUI D D 
R-x\AII-n-m: Input Impedance AnalogImpedance Analog Setup GUI 50, 75, 110, 10000 10000 
R-x\AGI-n-m: Signal Gain (in 

milliunits) 1000 Hard coded N/A 1000 
R-x\AFSI-n-m: 

Full Scale Range in 
millivolts AnalogFullRange 

Auto Calculated 
from voltage 
range on Analog 
Setup GUI  [+/-10- 200, 400, 800, 2000, 4000 2000 
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TMATS 
Attribute (05/07) 

TMATS 
Description 

G2 Name / Hard Coded Value G2 Location Acceptable Values Default Values 

->20,000; +/-5--
>10,000, etc.] 

R-x\AOVI-n-m: Input Offset Voltage 0 Hard coded N/A 0 
R-x\AIT-n-m: 

Type of Input Signal  
Derived from 
Analog Setup GUI 
Impedance D, S  S 

R-x\AV-n-m: Audio Present N Hard coded N/A N 
R-x\AF-n-m: 
 

Format AnalogCaptureMode 

Analog Setup 
GUI.  Only 2 (2's 
compliment) and 
O (other) are 
allowed. 1, 2, F, O. O  

PCM Channels 
R-x\PDTF-n: PCM Data Type 

Format  1 for Format 1 (IRIG 106 Ch4/8) Hard coded N/A 1 
R-x\PDP-n: PCM Mode 

(throughput, 
packed, unpacked.) 

TM for Throughput Mode; 
PFS for Packed Mode  PCM Input GUI. 

TM, UN, PFS TM 
R-x\ICE-n PCM Input Clock 

Phase PCM Input Clock Phase PCM Input GUI 0, 180 0 
R-x\IST-n PCM Input Source PCMInputType. PCM Input GUI RS422, TTL TTL 
R-x\ITH-n: Input Threshold 

(volts) 1.8 Hard coded N/A 1.8 
R-x\ITM-n PCM Input 

Impedance 
PCM Input Impedance; HIGH-Z 
or LOW-Z PCM Input GUI HIGH-Z, LOW-Z LOW-Z 

R-x\PTF-n: PCM Video type 
Format. NONE Hard coded N/A NONE 

R-x\MFF\E-n: PCM Minor Frame 
Filtering Enabled F for False Hard coded N/A F 

R-x\POF\E-n: PCM Post Process 
Overwrite and 
Filtering Enabled 

F for False Hard coded 
N/A F 
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TMATS 
Attribute (05/07) 

TMATS 
Description 

G2 Name / Hard Coded Value G2 Location Acceptable Values Default Values 

V-y\TDS\PII-n: PCM Input 
Impedance 

Value of impedance if ITM=LOW-
Z 

Derived from PCM 
Input GUI; Rev B 
Board supports 
only 75 Ohms. 50, 75 Ohms 75 Ohms 

V-y\TDS\PSR-n: PCM Input Source PCM Input Source PCM Input GUI Internal, External External 
M-x\ID: Data Source 

Identifier Channel Name See R-1\DSI-n: Any DataLink<chan> 
M-x\BSG1: Base band is PCM PCM Hard coded N/A PCM 
M-x\BB\DLN: Data Link Name Channel Name See R-1\DSI-n: Any DataLink<chan> 
P-d\DLN: Data Link Name N/A N/A Any DataLink<chan> 
P-d\D1: 

PCM Input Code PcmInputCode PCM Input GUI 
NRZ-L, NRZ-M, NRZ-S, 
BIO-L, BIO-M, BIO-S, 
RNRZ-L, OTHER NRZ-L 

P-d\D2: PCM Bit Rate PcmRate PCM GUI Any 10000000 
P-d\D3: PCM Data 

Encryption U  Hard coded N/A U 
P-d\D4: PCM Input Polarity PcmInputPolarity PCM Input GUI I, N N 
P-d\D5 PCM Auto 

Correction N Hard coded N/A N 
P-d\D6: PCM Data Direction PcmInputCode PCM Input GUI N, R N 
P-d\D7: PCM Randomizer PcmInputCode PCM Input GUI N, Y N 
P-d\D8: PCM Randomizer 

Length PcmInputCode PCM Input GUI “STD”, “OTH”, “N/A” “N/A” 
P-d\TF Type Format PCMFormatType PCM Frame 

Format GUI 
ONE, TWO, 1553, BUS, 
ALTD, PKTM, OTHER  N/A 

P-d\F1: PCM Common 
Word Length 

PcmWordSize 
Default = 4 

BDE Setup GUI; 
PCM Frame 
Format GUI Any N/A 

P-d\F2: PCM Word Transfer 
Order 

PcmWordOrientation 
Default = MSB 

BDE Setup GUI; 
PCM Frame 
Format GUI L, M N/A 

P-d\F3: Normal Word Parity PcmParity 
Default = None 

PCM Frame 
Format GUI EV, OD, NO N/A 
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TMATS 
Attribute (05/07) 

TMATS 
Description 

G2 Name / Hard Coded Value G2 Location Acceptable Values Default Values 

P-d\F4: Parity Transfer 
Order PcmParityTransferOrder PCM Frame 

Format GUI L, T N/A 
P-d\MF\N: Number Minor 

Frames in a Major 
Frame 

PcmMinorsPerMajor 
Default = 1 

Hard coded for 
BDE channels; 
PCM Frame 
Format GUI Any N/A 

P-d\MF1: Number of Words in 
a Minor Frame 

PcmTotalWords 
Default = 2 

BDE Setup GUI; 
PCM Frame 
Format GUI Any N/A 

P-d\MF2: Number of Bits in a 
Minor Frame calculated  

BDE Setup GUI; 
PCM Frame 
Format  GUI Any N/A 

P-d\MF3: PCM Sync Type PFT (fixed pattern) Hard coded FPT, OTH N/A 
P-d\MF4: PCM Frame Sync 

Length 

Pcm FrameSyncLength 
Default = Length of Sync Pattern, 
if valid; otherwise, 16. 

BDE Setup GUI; 
PCM Frame 
Format GUI Any N/A 

P-d\MF5: PCM Frame Sync 
Pattern 

PcmFrameSync 
Default = 2Sync Pattern Length -1 

BDE Setup GUI; 
PCM Frame 
Format GUI Any N/A 

P-d\SYNC1: In Sync Criteria MinorFramesToLock 
Default = 1 

PCM Frame 
Format GUI 

  

P-d\SYNC2: In Sync Pattern 
Criteria 

BitErrorsToLock 
Default = 0 

PCM Frame 
Format GUI 

  

P-d\SYNC3: Number Of 
Disagrees 

MinorFramesToDrop 
Default = 1 

PCM Frame 
Format GUI 

  

P-d\SYNC4: Out Of Sync Pattern 
Criteria 

BitErrorsToDrop 
Default = 1 

PCM Frame 
Format GUI 

  

P-d\ISF\N Number of 
Subframe ID 
Counters 

SubframeIdCounters 
Default = 0 PCM Framing GUI 

Any N/A 
P-d\ISF1-1 Subframe ID 

Counter Name Hard coded to ‘SFID’ 
PCM Subframe 
Synch Format 
GUI N/A N/A 
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TMATS 
Attribute (05/07) 

TMATS 
Description 

G2 Name / Hard Coded Value G2 Location Acceptable Values Default Values 

P-d\ISF2-1 Subframe 
Synchronization 
Type 

SubframeSyncType 
PCM Subframe 
Synch Format 
GUI N/A N/A 

P-d\IDC1-1 Subframe ID 
Counter Position 

SubframeCounterLocation 
Default = 1 

PCM Subframe 
Synch Format 
GUI Any N/A 

P-d\IDC2-1 ID Counter Minor 
Frame Word Length 

SubframeCounterWordLength 
(Same value as PcmWordSize) 

PCM Subframe 
Synch Format 
GUI N/A N/A 

P-d\IDC3-1 ID Counter MSB 
Starting Bit Location 

SubframeCounterStartBit 
Default = 1 

PCM Subframe 
Synch Format 
GUI Any N/A 

P-d\IDC4-1 ID Counter Length 
(in Bits) 

SubframeCounterLength 
(Calculated) 

PCM Subframe 
Synch Format 
GUI N/A N/A 

P-d\IDC5-1 ID Counter Transfer 
Order 

SubframeCounterOrder(same as 
PcmWordOrientation) 
Default = ‘Default’ 

PCM Subframe 
Synch Format 
GUI N/A N/A 

P-d\IDC6-1 ID Counter Initial 
Value 

SubframeCounterStartValue 
Default = 0 

PCM Subframe 
Synch Format 
GUI Any N/A 

P-d\IDC7-1 Initial Count 
Subframe Number 

SubframeInitialValue (same as 
SubframeCounterStartValue) 

PCM Subframe 
Synch Format 
GUI Any N/A 

P-d\IDC8-1 ID Counter End 
Value SubframeCounterEndValue 

PCM Subframe 
Synch Format 
GUI Any N/A 

P-d\IDC9-1 End Count 
Subframe Number 

SubframeLastValue (same as 
SubframeCounterEndValue) 

PCM Subframe 
Synch Format 
GUI Any N/A 

P-d\IDC10-1 
Count Direction SubframeCountDirection 

Default = ‘Increasing’ 

PCM Subframe 
Synch Format 
GUI INC, DEC N/A 

P-d\COM: PCM Randomizer  PcmInputCode PCM Input GUI 9, 11, 20, 23, OFF, DM-S, N/A 
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TMATS 
Attribute (05/07) 

TMATS 
Description 

G2 Name / Hard Coded Value G2 Location Acceptable Values Default Values 

comment detail DM-M, MDM-S, MDM-M 
V-y\TDS\BLA-n: Bitsync Lag Adjust Bitsync Lag Adjust Advanced Input YES, NO NO 
V-y\TDS\BOE-n: Bit Sync Output 

Enabled BitSync OutputEnabled PCM Setup GUI YES, NO NO 
V-y\TDS\BCP-n: Bitsync Clock 

Phase Bitsync Clock Phase BitSync Setup 
GUI 0, 180 Degrees 180 Degrees 

V-y\TDS\BIM-n: Bitsync Impedance  Bitsync Impedance  BitSync Setup 
GUI 

50 Ohms, 75 Ohms, 10 
kOhms 10 kOhms 

V-y\TDS\BIP-n: Bitsync Input 
Polarity Bitsync Input Polarity BitSync Setup 

GUI Normal, Inverted Normal 
V-y\TDS\BIS-n: Bitsync Input 

Source Bitsync Input Source BitSync Setup 
GUI Single Ended, Differential Single Ended 

V-y\TDS\BPD-n: Bitsync Percent 
Deviation Bitsync Percent Deviation BitSync Setup 

GUI Any 2 
V-y\TDS\BPL-n: Bitsync Percent 

Loop Bandwidth Bitsync Percent Loop Bandwidth BitSync Setup 
GUI Any 0.3 

V-y\TDS\BIC-n: 

Bitsync Input Code 
(D1) BitSyncInputCode BitSync Setup 

GUI 

BIO-S, BIO-M, BIO-L, NRZ-
S, NRZ-M, NRZ-L, DM-S, 
DM-M, MDM-S, MDM-M, 
OFF, +RNRZ-9, +RNRZ-
11, +RNRZ-15, +RNRZ-20, 
+RNRZ-23, -RNRZ-9, -
RNRZ-11, -RNRZ-15, -
RNRZ-20, -RNRZ-23, NRZ-L 

V-y\TDS\BIR-n: Bitsync Input Rate 
(D2) N/A N/A N/A N/A 

V-y\TDS\PCO-n: 

PCM Output Code PCM Output Code PCM Output GUI 

BIO-S, BIO-M, BIO-L, NRZ-
S, NRZ-M, NRZ-L, DM-S, 
DM-M, MDM-S, MDM-M, 
OFF, +RNRZ-9, +RNRZ-
11, +RNRZ-15, +RNRZ-20, 
+RNRZ-23, -RNRZ-9, -
RNRZ-11, -RNRZ-15, -
RNRZ-20, -RNRZ-23, NRZ-L 
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TMATS 
Attribute (05/07) 

TMATS 
Description 

G2 Name / Hard Coded Value G2 Location Acceptable Values Default Values 

V-y\TDS\PFSM-
n: Frame Sync Mask PcmFrameSyncMask 

Default = 2Sync Pattern Length -1 
BDE Setup GUI; 
PCM Framing GUI Any N/A 

V-
x\TDS\BIT_SLIP-
y: 

Maximum Frame 
Sync Bit Slip 

PcmFrameSyncMaxBitSlip 
Default = 0 

PCM Frame 
Format GUI 

  

V-y\TDS\BDE-
n\IC: 

BDE Input 
Channels BDE Input Channels BDE Setup GUI BDE Input Channels N/A 

V-y\TDS\BDE-
n\AN: 

BDE Algorithm 
Name BDE Algorithm Name BDE Setup GUI Any N/A 

V-y\TDS\BDE-
n\MW: 

BDE Maximum Wait 
Time BDE Maximum Wait Time BDE Setup GUI Any N/A 

V-y\TDS\UBS-n Using Bit Sync Yes or No PCM Setup GUI Yes, No N/A 
UART Channels 

R-x\UTF-n: UART format (0 is 
only valid value) 0 Hard coded N/A 0 

R-x\NUS\N-n: Number of sub 
channels 1 Hard coded N/A 1 

R-x\USCN-n-m: sub channel 
number 1 Hard coded N/A 1 

R-x\UCNM-n-m: sub channel name SubChannel_1 Hard coded N/A “SubChannel_1” 
R-x\UCR-n-m: 

baud rate SerialRate UART Setup GUI 
1200, 2400, 4800, 9600, 
19200, 38400, 115200, 
230400, 460800, 921600 115200 

R-x\UCP-n-m: Parity SerialParity UART Setup GUI O, E, N N 
R-x\UCB-n-m: # data bits SerialDataBits UART Setup GUI 7, 8 8 
R-x\UCS-n-m: # stop bits SerialStopBits UART Setup GUI 0, 2 0 

Video Channels 
R-x\VED-n: video encoding 

delay VideoEncodingDelay Video Setup GUI Any 300 
R-x\VTF-n: 

Video type format VideoPacketFormat 

Video Setup GUI; 
only Formats 0 
and 1 are 
supported today 0, 1, 2 0 
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TMATS 
Attribute (05/07) 

TMATS 
Description 

G2 Name / Hard Coded Value G2 Location Acceptable Values Default Values 

R-x\VXF-n: 
type of video carried 
for Xon2 formats 
(mpeg2) 

0 (for MPEG-2) 

Comes from ini 
file name, but all 
are mpeg2 so 
could consider it 
hard coded 0 0 

R-x\VST-n: video signal input 
type 1 (for composite) Hard coded 1 1 

R-x\VSF-n: video signal format 
type 1 (for ntsc) or 2 (for pal) Comes from ini 

file name Any 1 
R-x\CBR-n: Only one of CBR 

(Constant) or VBR 
(Variable Peak) Bit 

Rate allowed 

setupIndex Comes from ini 
file name Any 1000000 

R-x\VBR-n: setupIndex Comes from ini 
file name Any 0 

R-x\VDA-n: Video Data 
Alignment  L for Little Endian Hard coded N/A L 

V-y\TDS\VID-
n\MPT: 

Packet Type 
(transport or 
program stream) 

setupIndex Comes from ini 
file name 
 
 PROGRAM, TRANSPORT TRANSPORT 

MIL-STD-1553 Channels 
R-x\BTF-n MIL-STD-1553 Bus 

Data Type Format 1 (for MIL-STD-1553B Data) Hard coded 1 1 
R-x\MRF\E-n: MIL-STD-1553 

Filtering Enabled F for False Hard coded N/A F 
R-x\MOF\T-n: MIL-STD-1553 Post 

Process Overwrite 
and Filtering 
Enabled 

F for False Hard coded 

N/A F 
B-x\DLN: DataLink Name Channel Name See R-x\DSI-n: Any DataLink <chan> 
B-x\TA: Test Item Description 1553 Setup GUI Any N/A 
B-x\BP: Bus Parity OD Hard coded N/A OD 
B-x\NBS\N: Number of Buses 1 Hard coded N/A 1 
B-x\BID-n: Bus Number 1 Hard coded N/A 1 
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TMATS 
Attribute (05/07) 

TMATS 
Description 

G2 Name / Hard Coded Value G2 Location Acceptable Values Default Values 

B-x\BNA-n: 

Bus Name Chan    Bus0001 

Derived from 
Ch.10 channel 
number N/A Chan<chan> Bus0001 

B-x\BT-n: Bus Type 1553 Hard coded N/A 1553 
Ethernet Channels 

R-x\ENTF-n: Ethernet type 
format 0 Hard coded N/A 0 

R-x\NNET\N-n: Number of networks 
included in this 
channel 

1 Hard coded 
N/A 1 

R-x\ENBR-n-m: Network number Port Number Read from hconfig 
file N/A 1 

R-x\ENAM-n-m: Network name Port Name Read from hconfig 
file N/A Any 

Arinc 429 Channels 
R-x\ABTF-n: ARINC 429 Bus 

type format 1 Hard coded N/A 0 
R-x\NAS\N: Number of sub 

channels 1 Hard coded N/A 1 
R-x\ASN-n-m: sub channel 

number 1 Hard coded N/A 1 
R-x\ANM-n-m: sub channel name A429_<ch10#> Hard coded N/A A429_<chan> 
B-x\DLN: DataLink Name Channel Name See R-x\DSI-n: Any DataLink <chan> 
B-x\TA: Test Item Description 429 Setup GUI Any Any 
B-x\BP: Bus Parity Bus Parity 429 Setup GUI NO, OD OD 
B-x\NBS\N: Number of Busses 1 429 Setup GUI N/A 1 
B-x\BID-n: Bus Number 1 Hard coded N/A 1 
B-x\BNA-n: 

Bus Name Chan____ Bus0001 

Derived from 
Ch.10 channel 
number N/A Chan<chan>_Bus0001 

B-x\BT-n: Bus Type A429 Hard coded N/A A429 
End of Table 
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